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What is PassageWay Solution?

AT&T PassageWay™ Solution is a collection of software applications that runs
with Microsoft®” Windows™ operating system version 3.1 or later. These
applications provide you with an interface between your IBM®-compatible
personal computer and a DEFINITY Communications System via your AT&T
7400 Series or CALLMASTER"telephone. PassageWay Solution increases
your telecommunication capabilities by providing the following applications:

s AT&TBuzz
AT&TBuzz is an application that notifies you of incoming calls and
enables you to view the calling party number (referred to as caller ID in
this document), if available. AT&TBuzz enables you to handle incoming
calls from your PC.

= AT&TCall
AT&TCall is a card file application that enables you to maintain names,
addresses, telephone numbers, and other information you desire. With
AT&TCall, you can place calls directly from your PC.



I ntroduction

= Log Viewer
Log Viewer is an application that enables you to access information
from the call log, which stores a record of calls you make using
AT&TCall and receive while AT&TBuzz is running.

= AT&TConnect
AT&TConnect is the management software that provides the basis for
the other PassageWay software applications, and the diagnostic
features to troubleshoot these applications. AT&TCall and AT&TBuzz
require AT&TConnect to be running to connect these applications with
the DEFINITY system, enabling you to fully use these applications.

PassageWay Solution also provides the following features:

= autodialing using the Hayes”command set, which is the same
command set used by most modems

= the ability to use Dynamic Data Exchange (DDE) to link PassageWay
applications with other Windows applications

User Responsibilities

Before using any of the PassageWay applications, you should be familiar with
basic Windows functions and procedures. If not, consult your Microsoft
Windows User's Guide.

You also may need to contact your PC vendor for information on configuring
your PC to meet PassageWay Solution requirements.

1-2



Introduction

Conventions Used in this Guide

The following conventions are used in this guide:

Commands and text you should enter appearin this style of
type.

Values, instructions, and prompts that appear on the screen are i n
this style of type.

Key names that are always located on the keyboard in the same place
appear in boxes, as in [ ENTER |.

Key combinations (holding down one key while pressing another key)
are connected with hyphens; for example: [ SHIFT |—[ 1AB ].

The terms option buttons and radio buttons refer to the same object.

Throughout this document, the term DEFINITY refers to all versions of
the following systems:

— DEFINITY G1, G2, and G3
— System 75

— System 85

Throughout this document, the terms telephone and phone refer to all
7400 Series and CALLMASTER telephones.

Getting Help

If you have questions about or problems with the PassageWay applications
that this user’s guide does not resolve, call the AT&T Technical Service Center

at 1-800-422-6622 or your AT&T Authorized Dealer.
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Installing and Setting Up
PassageWay Solution

Overview

This chapter provides the procedures for installing PassageWay Solution.
Installation of PassageWay Solution consists of the following steps:

1. [Installing the PassageWay adapter,| which provides an interface between
your PC and telephone

2. |Installing the PassageWay software|onto the hard disk of your PC and
setting up AT&TConnect for your system

3. [Setting up AT&TBuzz|

Before installing PassageWay, make sure you have the PassageWay
components and an available serial (COM) port on your PC.
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PassageWay Components

PassageWay consists of the following components:
= the PassageWay adapter
The PassageWay adapter provides an interface between your telephone

and an available serial (COM) port on your PC by connecting to the
following objects:

— the Line jack on your telephone
— the wall jack in your office
— the serial port on your PC
= software (one 3.5-inch, 1.44 MB, high-density diskette)

[] NOTE:
PassageWay Solution is also available on a 5.25-inch, 1.2 MB
diskette. To receive the software on a 5.25-inch diskette,
complete the registration card, specify that you want the software
on a 5.25-inch diskette, and return the registration card.

= this user's manual and a quick reference
= a 9-pin to 9-pin cord
This cord connects the PassageWay adapter to the serial port on your

PC. If your PC has a 25-pin serial port, connect the 9-pin to 9-pin cord
to a 9-pin to 25-pin adapter (not supplied).

= a 7-foot, 4-pair, modular phone cord (D8W)

This modular phone cord connects the PassageWay adapter to your
telephone.
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Figure 2-1 shows the PassageWay Solution components.
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8-Pin to 8-Pin Cord

Figure 2-1. PassageWay Solution Components
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Figure 2-2 shows the components of the PassageWay adapter.

LED

Figure 2-2. Components of the PassageWay Adapter
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PassageWay Requirements

To use the PassageWay applications, you must have the following

components:

= an IBM-PC compatible or PS/2°-compatible PC with the following
hardware:

an 80286 or higher processor (an 80386 or higher model number
is recommended)

an available serial port
a minimum of 2 MB of RAM (4 MB is recommended)

a 3.5-inch, 1.44 MB, high-density drive. (If you do not have a 3.5-
inch drive, you can order PassageWay Solution on a 5.25-inch
diskette.)

a hard disk with 2 MB of space available
a VGA monitor

a Windows-compatible pointing device (a mouse or trackball is
recommended)

NOTE:
If all the serial ports in your PC are already in use, you may wish
to purchase an additional serial port to use with PassageWay

Solution. Consult for information on choosing a

suitable serial port for PassageWay Solution.

= Microsoft Windows 3.1 or later release running in standard or enhanced

mode
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6

an AT&T 7400 Series or CALLMASTER telephone connected to a

DEFINITY system that is configured and operating properly.
PassageWay Solution runs on all versions of the following systems:

— DEFINITY G1, G2, and G3
— System 75
— System 85

Throughout this document, the term DEFINITY is used to refer to all of
the systems listed above.

The PassageWay adapter requires auxiliary power (either from the
closet or from an auxiliary power supply). Consult your System Manager
to determine whether your telephone has auxiliary power. (The System
Manager may be the Telecommunications Manager in your company.)

PassageWay Solution requires a display telephone for caller ID
capabilities. However, you can use a nondisplay telephone if your
extension is administered as a display telephone by the System
Manager. Consult your System Manager.

The functionality of the PassageWay applications depends on the type
of telephone you are using. Any differences in functionality are noted
throughout this document.

Before installing the PassageWay software, you must know the following
information:

whether your telephone has auxiliary power (either from the closet or
from an auxiliary power supply). The PassageWay adapter requires
auxiliary power. You can obtain this information from your System
Manager.

the COM port number (that is, COM1, COM2, COMS3, or COM4) to
which you are connecting the PassageWay adapter.
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[] NOTE:
PassageWay applications can run on a network, but they are not network
aware (that is, PassageWay applications do not support file sharing). If you are
on a local area network (LAN) and have a workstation with a local hard disk,
install the PassageWay software on the local hard disk. If you are on a LAN
and have a workstation that does not have a local hard disk, install the
PassageWay software in your private directory on your fileserver.
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Installing the PassageWay Adapter

The PassageWay adapter provides an interface between your PC and your
telephone, enabling you to access the DEFINITY system from your PC. The
PassageWay adapter has a DB-9 connector for 9-pin serial ports. If you have
a 25-pin serial port on your PC, use a 9-pin to 25-pin adapter to connect the
PassageWay adapter to your serial port

[] NOTE:

Do not install the PassageWay adapter while you are active on a
call.

To install the PassageWay adapter, perform the following steps:
1. Turn off your PC.
2 . Unplug the line cord from your telephone.

3. Connect the line cord to the jack labeled "Line" on the PassageWay
adapter|(Figure 2-3).|
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Figure 2-3. Connecting the Line Cord to the PassageWay Adapter
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Check the LED on the top of the PassageWay adapter.
If the LED is "on," proceed to step 5.

If the LED is "off," proceed to (Troubleshooting).

Connect one end of the 9-pin to 9-pin cord to the DB-9 connetor on the
PassageWay adapter.

Connect the other end of the 9-pin to 9-pin cord to the serial (COM) port
on your PC. If your PC has a 25-pin serial (COM) port, connect this cord
to a 9-pin to 25-pin adapter, and then connect the 9-pin to 25-pin
adapter to the 25-pin serial (COM) port.

Connect one end of the 7-foot, 4-pair, modular phone cord (D8W) to the
jack labeled "Phone" on the PassageWay adapter|(Figure 2-4).
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Figure 2-4. Connecting the Modular Phone Cord to the PassageWay Adapter
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8. Connect the other end of the 7-foot, 4-pair, modular phone cord (D8W)
to the Line jack on your telephone.

9. Turn on your PC.
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Installing the PassageWay Software

The PassageWay software includes an installation program that automatically
installs the PassageWay applications onto the hard disk of your PC. To install
the PassageWay software, perform the following steps:

1.
2.
3.

Insert the PassageWay diskette into the diskette drive of your PC.

Access Windows.
From Program Manager, select Run. .. in the File menu.

The Run dialog box appears.

Depending on the diskette drive in which you inserted the PassageWay
diskette, peform one of the following steps:

— If the diskette is in the A: drive, type a: \ set up in the Command
Line box and select the OK button.

— If the diskette is in the B: drive, type b: \ set up in the Command
Line box and select the OK button.

The PassageWay Installation window appears.
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PassageWay installation

AT&T PassageWay™ Solution Setup

AT&T PassageWay Setup

Welcome to AT&T PassageWay for DEFINITY Version 1.0 for
Windows.

This program will install PassageWay for DEFINITY on your computer.
Please follow the simple instructions.

You will need to provide the following information during the Setup
procedure:

1. The number of the communications port to which the
PassageWay adapter is connected [e.g. COM1, COMZ2].

If you do not have this information now, or wish to quit the Setup
procedure at any time, choose Cancel Setup.

To install PassageWay on your computer, choose the Contiue button
or press ENTER.

Figure 2-5. PassageWay Installation Window

5. Select the Continue button.

The following AT&T PassageWay Setup dialog box appears.
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3 AT&T PassageWay Setup

This program will place PassageWay into the
following directory, which it will create, if
necessary, on your hard disk.

If this directory is not acceptable, enter an alternate
directory name in the text box below.

When the location is acceptable, choose the
Continue button.

Location: |C:\PWDEF

Continue Cancel Setup

Figure 2-6. AT&T PassageWay Setup Dialog Box

This dialog box displays the name of the directory in which the
PassageWay applications will reside. If you want to change the default
directory for these applications, specify the directory where you want to
place these applications.

6. Select the Continue button.
The PassageWay applications and their associated files are loaded onto

the hard disk of your PC. A status message box appears, displaying the
status of the software installation.

2-15



Installing and Setting UE Pas&ageWaz Solution

Setup Disk

Source File:

A\SCAPI.DLL

Destination File:
C:\WINDOWS\SYSTEM\SCAPI.DLL

95%

Cancel

Figure 2-7. Sample Installation Status Message Box

After all of the files are loaded, the following message box appears.

AT&T PassageWay Setup

Setup has installed PassgeWay Solution
software successfully and added the

applications to the Program Manager.

AT&TConnect will now be started up to customize
Passageway Solution for use with your DEFINITY
comnunications system.

OK

Figure 2-8. Setup Complete Message Box

7.  Select the OK button.
The AT&T PassageWay Setup window closes, and the COM Port dialog

box appears. The AT&TConnect icon is displayed at the bottom of your
screen. You are now setting up AT&TConnect for your system.
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COM Port

Select the Conmmnication port for
your PassageWay adapter:

® coM1

O com2
O com3
O cons

Lo |

Figure 2-9. COM Port Dialog Box

Only available COM ports can be selected; other choices are "grayed."

Select the option button of the COM port to which you connected the
PassageWay adapter, and then select the OK button.

The following dialog box appears.

AT&TConnect

AT&TConnect must be configured for your
telephone and DEFINITY system before

PassageWay applications can operate your
telephone.

Press Continue to begin the setup process.

Continue Exit

Figure 2-10. AT&TConnect Dialog Box

At this point, you must configure AT&TConnect for use with your

telephone and DEFINITY system. Otherwise, the PassageWay
applications will be unable to operate your telephone.
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9. Select the Continue button.

The AT&TConnect Setup - Telephone dialog box appears. The
information displayed in the AT&TConnect Setup - Telephone dialog box
depends on the type of telephone you have. AT&TConnect determines
the type of telephone and then prompts you to specify one or more of
the following options for your telephone:

= telephone model

= the type(s) of expansion adjunct(s) (if any) connected to your
telephone

= the type(s) of external voice adjunct(s) (if any) connected to your
telephone

Figure 2-11] shows the AT&TConnect Setup - Telephone dialog box for
a 7405 telephone, and |Figure 2-12| shows this dialog box for a 7444
telephone.
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AT&TConnect Setup — Telephone

Use the controls below to select the options which
pertain to your 7405 telephone.

If any of these options are set incorrectly,
PassageWay will not work properly. If you
are unsure about any option, press the Help
button for more information.

~ Expansion Adjuncts

] Function Key Module Continue
(] pisplay Module
[] call Coverage Module

Cancel Setup

~ External Voice Adjuncts Advanced...

[] Speakerphone
[J Headset Adapter

Help

Figure 2-11. AT&TConnect Setup - Telephone
Dialog Box for a 7405 Telephone
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AT&TConnect Setup — Telephone

Use the controls below to select the options which
pertain to your 7444 telephone.

If any of these options are set incorrectly.
PassageWay will not work properly. If you
are unsure about any option, press the Help
button for more information.

External Yoice Adjuncts ™ ] Continue

] Speakerphone Cancel Setup
[[] Headset Adapter

Help

Figure 2-12. AT&TConnect Setup - Telephone
Dialog Box for a 7444 Telephone
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The dialog box in|Figure 2-11| contains the Advanced button, while the
dialog box in Figure 2-12 does not. The Advanced button appears in
because the telephone used in this example (a 7405
telephone) does not have a built-in display. Since the telephone used in
Figure 2-12 has a built-in display, the Advance button is not provided.

The Advanced button is provided for telephones that do not have
displays and gives you the ability to use display features such as
caller ID. By selecting the Advanced button, you can specify that your
extension has display capabilities even though you do not have a
display telephone. However, in order for your extension to have these
display capabilities, your System Manager must administer your
extension for display capabilities.
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[] NOTE:
If you use the Advanced button to specify that your non-display
telephone has display capabilities, PassageWay Solution
considers your telephone to be a display telephone.

10. From the AT&TConnect Setup - Telephone dialog box, select the
appropriate option(s) for your telephone. For more information regarding
the specific options for your telephone, select the Help button.

11. When you are finished, select the Continue button.

The AT&TConnect Setup - Lines dialog box appears. This dialog box
presents a representation of the buttons on your telephone.
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AT&TConnect Setup — Lines

The diagram below represents your telephone.

Indicate the location of each call appearance on your
telephone by pressing the corresponding buttons on the
diagram until each affected button displays the word "LINE"
as its caption.

You may remove the "LINE" caption from a button by simply
pressing it again.

When you are finished making changes, press the Continue
button.

I |
C | | ]
C I | I |
L_JE___II‘—

{Eoni. [] 1ansics I:l_—_____—]
-—E:]E:J
L__"__j £ontinive
T ==
CIE]E] LL
owsg. [ JL__1 Help

Figure 2-13. AT&TConnect Setup - Lines Dialog Box
for a 7405 Telephone with no Display

12.  Select the location of each call appearance on your telephone.
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The word "LINE" appears on each button you select. If you are not sure
where your call appearance buttons are located, lift your handset and
then press each button. If you hear dial tone and both the red and
green LEDs turn on when you press a button, that button is a call
appearance.
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NOTE :

D As part of the setup procedure, AT&TConnect will "press” the
buttons that you specify as call appearances in step 12. If you
specify a button that is programmed as a feature, AT&TConnect
may activate or de-activate the feature when it presses the

button. Be careful to select call appearances only.

13.  When you are finished, select the Continue button.

The AT&TConnect Setup - Line Confirmation dialog box appears.

2 AT&TConnect Setup — Line Confirmation

AT&TConnect will now confirm the locations
of your lines.

To begin, please take your telephone
off-hook, then press the Start button.

If you use your telephone or receive an
incoming call during this procedure, the
procedure will be cancelled automatically.

Stant

Cancel

Figure 2-14. AT&TConnect Setup - Line
Confirmation Dialog Box
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14. Lift the handset of your telephone, and then select the Start button.

AT&TConnect verifies that the buttons you selected are call
appearances, and then displays a message box. This message box
states the results of the test. Figure 2-15 shows the message box after
a successful test, while Figure 2-16 shows the message box after an
unsuccessful test.

AT&TConnect Setup

Your lines have been successfully confirmed.

You may hang up your phone now.

oK

Figure 2-15. AT&TConnect Setup Message Box for
a Successful Test

AT&TConnect Setup

AT&TConnect has encountered a button position marked as a
line which does not correspond to a call appearance.

Please verify your selections on the "AT&TConnect Setup -
Lines" window, then press Continue to start the confirmation
procedure again.

Also, please check your telepbone for any features which may
have been inadvertently activated or deactivated.

Figure 2-16. AT&TConnect Setup Message Box for
an Unsuccessful Test
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If the test is successful, hang up your handset, and proceed to step 15.

If the test is unsuccessful, hang up your handset, select the OK button,
and repeat steps 12 to 14. The incorrect button(s) that you marked as
call appearances will display "(No Line)" and will be grayed.

15. Select the OK button.
The AT&TConnect Setup - Line Labels dialog box appears.

= AT&TConnect Setup — Line Labels

PassageWay maintains a text label for each of your
telephone's call appearances. PassageWay applications use
these labels when referring to specific lines.

Your current line labels are shown below. To change a label,
press the corresponding button, then enter a new label.

When you are finished making changes, press the Continue
button.

Mer

gl

dgllds:

ok

(][
(Il

UUD&L[M[

LT

L]
[=]
[#]

0
z
<]

Figure 2-17. AT&TConnect Setup - Line Labels
Dialog Box for a 7405 Telephone with no Display

2-25



Installing and Setting UB Pas&igeWaz Solution

PassageWay applications such as AT&TBuzz use the Line Labels to

identify where calls are appearing on your telephone. You may
customize the labels to something that will be more meaningful to you.
These labels should be unique, and cannot be blank.

[] NOTE:
These labels are specific to PassageWay applications. Your
DEFINITY system has its own alphabetic labels that it applies to
the call appearance identifiers on the display of your telephone

(for example, a=).

16.  Perform one of the following steps:

— If you want to customize the Line Labels, perform the following
steps:

a. Select the label that you want to change.

The Edit Line Label dialog box appears.

b. Enter a new label (up to four characters) and select the
OK button.

If you want to customize another label, repeat steps A
and B.

When you are finished, proceed to step 17.

— If you do not want to modify the Line Labels, proceed to step 17.

17. Select the Continue button.

The AT&TConnect Setup - Line Labels dialog box closes.

If your telephone does not have a display, you are finished setting up

AT&TConnect. The AT&T PassageWay window appears, displaying the
AT&TBuzz, AT&TCall, AT&TConnect, and Log Viewer icons
The AT&TConnect icon also appears at the bottom of your screen.
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If your telephone has a display, the AT&TConnect Setup - Display
Features dialog box appears (Figure 2-18).

AT&TConnect Setup — Display Features

If the "Normal" and "Inspect" display features are assigned to buttons on your
telephone, PassageWay can use them to enhance its calling party ID capabilities.

Indicate the location of these feature buttons, if they are present on your
telephone, by pressing the corresponding button(s) on the diagram and selecting
the appropriate feature name from the popup menu.

When you are finished making changes, press the Continue button.

L | J[80251]

Figure 2-18. AT&TConnect Setup - Display Features
Dialog Box for a 7405 Telephone with a Display

The Normal and Inspect display feature buttons enhance the caller ID
capabilities of PassageWay Solution.

If your telephone does not have Normal and Inspect display feature
buttons, select the Continue button. You are finished setting up
AT&TConnect. The AT&T PassageWay window appears |(Figure 2-21).|
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If your telephone has Normal and Inspect display feature buttons
programmed, perform the following steps:

a.

Select the location of the Inspect display feature button on your
telephone.

A submenu appears displaying "Clear Button," "Normal," and
"Inspect.”

Select | nspect.

"Inspect” appears on the label of the button you selected.

Select the location of the Normal display feature button on your
telephone.

A submenu appears displaying "Clear Button," "Normal," and
"Inspect.”

Select Nor mal .

"Normal" appears on the label of the button you selected.

Select the Continue button.

The AT&TConnect Setup - Normal/lInspect dialog box appears.
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AT&TConnect Setup — Normal/lInspect

AT&TConnect will now confirm the locations of
your Normal and Inspect buttons.

To begin, please hang up if your are currently
off-hook, then press the Start button.

If you use your telephone or receive an

incoming call during this procedure, the
procedure will be cancelled automatically.

Start '

Figure 2-19. AT&TConnect Setup - Normal/Inspect
Dialog Box

f.  Make sure your phone is on hook (that is, hang up your handset)
and select the Start button.

AT&TConnect verifies the locations you specified for the Normal
and Inspect display feature buttons.

If the test is successful, the AT&T PassageWay window appears,
displaying the AT&TBuzz, AT&TCall, AT&TConnect, and Log
Viewer icons. The AT&TConnect icon also appears at the bottom
of your screen|(Figure 2-21).|

If the test is unsuccessful, the following message box appears.
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AT&TConnect Setup

AT&TConnect could not confirm the location(s) of your "Normal"
and "Inspect" buttons.

Please verify your selections on the "AT&TConnect Setup -
Display Features" window, then press Continue to start the
confirmation procedure again.

Also, please check your telephone for any features which may
have been inadvertently activated or deactivated.

Figure 2-20. AT&TConnect Setup Message Box for
an Unsuccessful Test

Select the OK button and then repeat steps A to F.
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Program Manager prdia

File QOptions Window Help

Ej ATST PassageWay
o = = e
g = = B

ATRTBuz ATSTCal  ATiTCormec! Log Viewer

Figure 2-21. AT&T PassageWay Window

The installation program puts the AT&TConnect icon in the StartUp group (if

the StartUp group already exists). If the StartUp group does not already exist,
PassageWay Solution creates it and places the AT&TConnect icon in it.

If AT&TConnect is in the StartUp group, every time you invoke Windows the

AT&TConnect software is automatically loaded, and the AT&TConnect icon
appears at the bottom of the screen.
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If you do not want AT&TConnect to be loaded automatically every time you
invoke Windows, remove the AT&TConnect icon from the StartUp Group
window. (See your Microsoft Windows User's Guide.) However, if you remove
the AT&TConnect icon from the StartUp group window, you must remember to
execute AT&TConnect manually before using other PassageWay applications.
AT&TConnect provides the communication interface between your PC and
your telephone. If AT&TConnect is not running, the other PassageWay
applications on your PC are unable to communicate with your telephone.

Now that the PassageWay software is installed, proceed to|"'Setting Up
AT&TBuzz."
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Setting Up AT& TBuzz

AT&TBuzz is a software application that enables you to manage incoming calls
(answer, hold, or drop) and view the calling party number (when available) for
each incoming call appearing at your telephone. (Throughout this document,
calling party number is referred to as caller ID.) When running, AT&TBuzz
monitors your phone for incoming calls. When you receive a call, the
AT&TBuzz window appears, notifying you of the call. The AT&TBuzz window
displays the state of all incoming calls that are currently present on your
telephone. If you want AT&TBuzz to be automatically initiated every time that
you enter Windows, add AT&TConnect and AT&TBuzz to your StartUp group.

Before you can start using AT&TBuzz, you must first set up the application.
AT&TBuzz provides several options that enable you to tailor AT&TBuzz to your
needs. Setting up AT&TBuzz consists of the following procedures:

1. Select the Run Mode option that best suits the way you will use
AT&TBuzz.

2. Set the user options.
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To set up AT&TBuzz initially, perform the following steps:
1. Double-click on the AT&TBuzz icon.

The AT&TBuzz Initialization dialog box appears.

. AT&TBuzz Initialization

Welcome to AT&TBuzz

Before this application will operate properly, you you must supply
some information.

Please follow the directions on the following screens. If you exit
the application before the initialization is complete, you will be
asked to provide the missing information the next time the
application is started.

Once the initialization is completed, the application will be
started up running in the background. Further customization of
the application can be done by double clicking on the icon and
selecting "Setup" from the menu.

Continue Exit

Figure 2-22. AT&TBuzz Initialization Dialog Box

2. Select the Continue button.

The Run Mode dialog box appears.
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Please select one of the following three options to determine the action
carried out by AT&TBuzz when Caller ID information is received with a
telephone call.

No Matching

Caller ID information is displayed in the AT&TBuzz window.
Match to AT&TCall File

The cards in a specified AT&TCall file are searched for telephone numbers
matching the Caller ID. If a match is found, information from the matching
card is displayed in the AT&T Buzz window.

Export via Paste Link DDE

The Caller ID is exported from AT&TBuzz to other Windows applications
using Dynamic Data Exchange [DDE]. This option requires a
user-customized interface in the applications receiving the Caller ID.

[~ Caller iD Options -
@ No Matching Continue |
O Match to AT&TCall File :
O Export via Paste Link DDE Exit

ATE&TCall File:

Broweze...

Figure 2-23. Run Mode Dialog Box

3. Proceed to['Setting the Run Mode Option."|

2-35



Installing and Setting Up PassageWay Solution

Setting the Run M ode Option

AT&TBuzz can run in one of the following modes:

=  No Matching
= [Match to AT&TCall File]

= [Export via Paste Link DDE|

Review the descriptions of all three modes to determine which mode would
best fit your needs.

No Matching Mode

When running in No Matching mode, AT&TBuzz displays on your PC the line,
State, and Caller ID (if available) for each incoming call. From the AT&TBuzz
window, you can answer, place on hold, or hang up incoming calls. You would
probably use this option if you do not plan on using the caller ID information
for database look-up.

To configure AT&TBuzz to run in No Matching mode, perform the following
steps:

1. Select the No Matching option in the Run Mode dialog box and select
the Continue button.

A message box states that the initialization process is complete.

2. Select the OK button.

The AT&TBuzz icon appears at the bottom of your screen.

2-36



Installing and Setting UB PassageWax Solution

Proyram Manaycer

[Fie Optiors Window _Help

h B < ——
ATSTCMl  AT&TConnect  LopViewes

AT&T Connec: ATETBuz

Figure 2-24. AT&TBuzz Running in No Matching Mode

3. Proceed to['Setting User Options."|
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Match to AT&TCall File Mode

The Match to AT&TCall File mode integrates AT&TBuzz with AT&TCall, giving
you a direct link between the caller ID of incoming calls and an AT&TCall file.
In this mode, you associate AT&TBuzz with an AT&TCall file. When you
receive an incoming call, AT&TBuzz automatically searches the telephone
numbers on every card in the AT&TCall file. If the caller ID from the incoming
call matches a telephone number in one of the cards in the AT&TCall file,
AT&TBuzz displays the text from the primary and secondary sort fields from
the card as the Call Label for the call. This gives you the ability to know the
identity of the caller before answering the call. For example, if the primary sort
field is Last Name, and the secondary sort field is First Name in the associated
AT&TCall file, AT&TBuzz displays Last Name, First Name for the Call Label. If
a match is found, you can have AT&TCall display the associated card. If a
match is not found, you can create a new card for this call and add the new
card to the card bank of the associated AT&TCall file.

In this mode, AT&TBuzz displays on your PC the Line, State, Caller ID (if
available), and Call Label (if available) for each incoming call. From the
AT&TBuzz window, you can answer, place on hold, or hang up incoming calls.
You should use this option you want to match the caller ID to an AT&TCall file.

To configure AT&TBuzz to run in Match to AT&TCall File mode, perform the
following steps:
1. Select the Match to AT&TCall File option in the Run Mode dialog box.
2. Click the mouse in the AT&TCall File box and type sanpl e. dex.
This associates AT&TBuzz with the sample AT&TCall file that was

copied to the hard disk of your PC when you installed the PassageWay
applications. If you do not want to use "sample.dex," create a hew

2-38



Installing and Setting UB PassageWax Solution

AT&TCall file, and then associate your new AT&TCall file with

AT&TBuzz after you finish setting up AT&TBuzz. Refer to Chapter 4 to

create a new AT&TCall file.| Refer to Chapter 3 to [associate a new|

T&TCall file with AT&TBuzz.|

3. Select the Continue button.

The Area Code dialog box appears.

In order to match incoming Caller ID to entries
in your AT&TCall file, the following information

is needed.

Enter the local Area Code:

Area Code

8X

Cancel

Figure 2-25. Area Code Dialog Box

4. Enter the area code for the local area and select the OK button.

AT&TBuzz displays a message box indicating that the initialization
process is complete.

5. Select the OK button.

The AT&TBuzz icon and the icon for the associated AT&TCall file

appear.
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Prugram Mauager
__Fiie Options Window Help

..
T

ATETConnect  Lop Viewer

N PR
ATET ATRTCal -  AT3TBuzz-
SAMPLE DEX SAMPLE DEX

Figure 2-26. AT&TBuzz Running in Match to AT&TCall File Mode

6. Proceed to['Setting User Options."|

Export via Paste Link DDE Mode

The Export via Paste Link DDE mode enables AT&TBuzz to export the caller
ID, the line label, and the full contents of the display message that arrived with
the call to another Windows application that supports Paste Link DDE. In turn,
AT&TBuzz may receive a string from that other Windows application and use
that string as a Call Label.
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To use this option, you must meet the following requirements:

= The application that receives the caller ID must support Paste
Link DDE.

®" You must have a user-customized interface in the application that
receives the caller ID. Examples are provided in the Readme file

provided with PassageWay Solution.

For more information on Export via Paste Link DDE mode, refer to

[Appendix C.|

[]

NOTE:

When you configure AT&TBuzz to run in Export via Paste Link
DDE mode, the contents of the Windows clipboard are
overwritten. Therefore, if you have information on the clipboard
that you want to save, go to another application and paste this
information into a file before initializing AT&TBuzz to run in Export
via Paste Link DDE mode. However, this only occurs when you
first configure AT&TBuzz to run in Export via Paste Link DDE
mode or select the Initialize Paste Link DDE option from the File
menu. The contents of the clipboard are not affected during
operation.

To configure AT&TBuzz to run in Export via Paste Link DDE mode, perform
the following steps:

1.

Select the Export via Paste Link DDE option in the Run Mode dialog

box and select the Continue button.

AT&TBuzz displays a message box indicating that the initialization
process is complete.

Select the OK button.

The following dialog box appears.
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AT&TBuzz

Do you want to initialize AT&TBuzz for Exporting
via Paste Link DDE now?

cause the Windows Clipboard to be overwritten.

Q WARNING: Initializing Paste Link DDE will now

If you choose "No", you must select "Initialize
Paste Link DDE" from the "Setup" menu before
AT&TBuzz will export any Caller ID information.

Yes No

Figure 2-27. AT&TBuzz Initialization Dialog Box

3. Select the Yes button.

The following message box appears.

s AT&TBuzz

Paste Link DDE has been initialized in

AT&TBuzz. If you haven't done so already, you
0 must now do an Edit/Paste Link in the

application that is to receive the Caller ID from

AT&TBuzz before any information can be
exchanged.

Figure 2-28. AT&TBuzz Message Dialog Box

4. Select the OK button.

The AT&TBuzz icon appears at the bottom of your screen.
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Pruyrem Mansyer
Ele _Options W’ndw Help
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ATLTCHl  ATATConrect LWVM
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Figure 2-29. AT&TBuzz Running in Export via Paste Link DDE Mode

5. Proceed to['Setting User Options."|
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Setting User Options

The AT&TBuzz user options enable you to further tailor AT&TBuzz to your
needs. You can set the following user options:
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Show AT&TBuzz on Ringing

You can set the AT&TBuzz window to appear automatically when a call
rings at your telephone. However, if you do not want to be distracted by
this window "popping up" every time your phone rings, you can set the
AT&TBuzz window to be opened manually (that is, you must double-
click on the AT&TBuzz icon when you want to access the AT&TBuzz
window and answer a call). By default, the AT&TBuzz window appears
automatically when a call rings at your telephone.

Show AT&TCall Card

If you are running AT&TBuzz in Match to AT&TCall File mode, you can
set whether you want AT&TBuzz to show automatically the card that is
associated with an incoming call. By default, you must select the Show
Card button in the AT&TBuzz window to view the associated card. If you
want AT&TBuzz to automatically show the associated card, you may
specify whether you want the card displayed when the call rings at your
telephone, or when you answer the call.

Automatic Inspect Mode

You can specify whether you want AT&TBuzz to automatically inspect
every incoming call that rings at your telephone. In Automatic Inspect
mode, AT&TBuzz provides the caller ID automatically for every incoming
call (if available). To use Automatic Inspect mode, you must have
Normal and Inspect display feature buttons programmed on your
telephone. By default, Automatic Inspect Mode is disabled.

[] NOTE:
If you enable Automatic Inspect Mode, you should always answer
calls from AT&TBuzz, instead of answering calls directly from the
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telephone. This prevents you from interrupting an "inspection™ in
progress and answering a call other than the one you are
expecting to answer.

Call Logging
AT&TBuzz enables you to turn call logging on or off for incoming calls. If

you turn on call logging, you have the option of logging all incoming
calls (that is, calls that were answered and calls that were unanswered)
or only those calls that were answered. Unanswered calls include those
calls that were answered at another extension or by voice mail. By
default, AT&TBuzz logs all incoming calls.

Answering Second Call

AT&TBuzz enables you to specify what should be done automatically to
an active (incoming) call when you attempt to answer another call. By
default, AT&TBuzz prompts you to specify what should be done with the
active call every time you attempt to answer another call. You can set
AT&TBuzz to either automatically place the active call on hold or drop
the active call when you attempt to answer another call. For example, if

you know that you always want to place the active call on hold and
answer the next call, select Auto-Hold First Call. You may want to keep

the default setting to determine whether you want to automate this
process.

If you are active on an outgoing call and you attempt to answer a

second call, AT&TBuzz will always prompt you to drop the active call to
answer the second call. If you want to place the active call on hold, you
must use the telephone. This operation is not affected by the Answering

Second Call option.

Local Area Code
When running in Match to AT&TCall File mode, AT&TBuzz requires the

local area code.
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To set the user options, perform the following steps:

1.

Double-click on the AT&TBuzz icon to open the AT&TBuzz window.

The AT&TBuzz window appears.

The Options dialog

depend on whethe
File mode.

Select Opti ons. ..

from the Setup menu.

box appears. The contents of the Options dialog box
r you are running AT&TBuzz in Match to AT&TCall

" Show ATSTCall Card

O On Button Selection
@ Automatically on Answes
O Automatically on Ringing

Call Logging
@ Al Incoming Calks
QO Answesed Calls Only
QO No Incoming Calls

O Auto-Hold Fisst Call
Q Auto-Drop Furst Call
® Choose to Hold oc Drop

" Answering Second Call =™ |

O Automatic Iinspect Mode
X Show AT&TBuzz on Ringing

Local Asea Code:

OK

Cancel | | Hebp

Figure 2-30. Options Dialog Box when AT&TBuzz is
Running in Match to AT&TCall File Mode
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Options

Callloggng™ ] Fgmnerng Second Cal™)
@ All Incoming Caliz O Auto-Hold Farst Call

O Answered Calis Only QO Auto-Drop Fisst Call
QO No incoming Calls @ Choose to Hold o« Diop

O axomsic nspect Mode X Show AT&TBwz2 on Ringing

L_ox | [Comcel | [ tew ]

Figure 2-31. Options Dialog Box when AT&TBuzz
Is Running in No Matching or Export via Paste Link
DDE Modes

3. Select the appropriate options.
4. When you are finished, select the OK button.
5. Minimize the AT&TBuzz window.

PassageWay is now installed and configured. Refer to Chaptersthrough
for information on how to use the PassageWay applications.

[] NOTE:
If you set AT&TBuzz to run in Match to AT&TCall File mode, and you do not
want to use "sample.dex," create a new AT&TCall file, and then associate your
new AT&TCall file with AT&TBuzz. Refer to Chapter 4 to [create a new|
IAT&TCall file.| Refer to Chapter 3 to associate a new AT&TCall file with
AT&TBuzz|("Changing the AT&TCall File Associated with AT&TBuzz").|
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Using AT& TBuzz

Overview

This chapter provides the following information:

= |a description of AT&TBuzz|

[the procedures for running AT&TBuzZ|

lhelpful hints describing how to use AT&TBuzz|

[the tasks you will perform regularly while using AT&TBuzz|

[a description of all the AT& TBuzz menu options|
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What Is AT& TBuzz?

AT&TBuzz is a software application that enables you to manage incoming calls
(answer, hold, or drop) and view the calling party number (when available) for
each incoming call appearing at your telephone. (Throughout this document,
calling party number is referred to as caller ID.)

[] NOTE:

If you do not receive caller ID on outside calls, consult your
System Manager.

Figure 3-1 shows the AT&TBuzz window running in Match to AT&TCall File
mode.
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Figure 3-1. Sample AT&TBuzz Window
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The AT&TBuzz window consists of the following components:
= Call record list box
= Menu bar

= Tool bar

Figure 3-2 shows the components of the AT&TBuzz window.

Menu Bar

h apegt New Catd

H e State Caller ID Call Label n
“ Hold 34304 Beyer Jeanne | H
Tool Bar Call Record List Box

Figure 3-2. Components of the AT&TBuzz Window

The call record list box displays the call records for each incoming call
currently appearing at your telephone (that is, calls that are ringing, active, or
on hold). A call record consists of the following components:

= Line Label, which indicates the specific line button that the call is on.
You can customize these labels in AT&TConnect to identify each line
button on your telephone.
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= Call State, which indicates the status of the incoming call. Possible call
states are Ring, Active, or Hold.

= Caller ID (if available), which is the call origination information that may
be delivered with the incoming call. In addition, the following messages
may appear in this column:

— Inspecting

— Not Available
If this column is blank, you may initiate an inspection of the caller ID if
you have an inspect button programmed. To perform an inspection,
select the record in the list box and select the Inspect button from the
Tool bar. (Refer to['Using Caller ID Information'| for more information
regarding the messages that may appear in the Caller ID column.)

= Call Label (if available), which is present if AT&TBuzz is operating in
Match to AT&TCall File mode or Export via Paste Link DDE mode.
Depending on the run mode, this field may contain information from an
AT&TCall file or another Windows application.

When an incoming call rings at your telephone, the call record for that call
appears on the first line of the call record list box and is highlighted (selected).
At this point you can select the Answer button from the Tool bar to answer the
call. If other calls ring at your telephone while you are active on the first call,
AT&TBuzz displays the call records for each call in the order in which they
started ringing. The oldest call appears at the top of the call record list box,
and the newest call appears at the bottom. These call records will remain in
the call record list box as long as they are ringing, active, or held. As soon as
you hang up on a call, the record for that call is removed from the call record
list box.

When you want to answer a call, hang up a call, or place a call on hold, you
must select the related call record in the call record list box (using the mouse
or the arrow keys on your keyboard) and then select the appropriate button
from the Tool bar. The Tool bar may contain either two or three buttons
(depending on the run mode in which AT&TBuzz is operating) and a count of
the number of currently active incoming calls. The meanings of these buttons

3-4



Us ng AT& TBuzz

depend on the call state of the selected call record. Using these buttons, you
can answer a ringing or held call, hang up an active call, inspect for caller
information for a call, or show the associated AT&TCall card (if available).

You can set AT&TBuzz to run in one of the following three modes:

No Matching

When running in No Matching mode, AT&TBuzz displays the Line,
State, and Caller ID for each incoming call. In this mode, the AT&TBuzz
window does not display a Call Label for each call.

Match to AT&TCall File

The Match to AT&TCall File mode integrates AT&TBuzz with AT&TCall.
In this mode, you associate an AT&TCall file with AT&TBuzz. When you
receive an incoming call, AT&TBuzz automatically searches the
telephone numbers on every card in the AT&TCall file. If the caller ID
from the incoming call matches a telephone number in one of the cards
in the AT&TCall file, AT&TBuzz displays the primary and secondary sort
fields from the card as the Call Label for the call. For example, if the
primary sort field is Last Name, and the secondary sort field is First
Name in the associated AT&TCall file, AT&TBuzz displays the text from
the Last Name, First Name fields for the Call Label. If a match is found,
you can have AT&TCall display the associated card automatically from
AT&TBuzz. If a match is not found, you can create a new card for this
caller and add the new card to the card bank of the associated
AT&TCall file.

When running in Match to AT&TCall File mode, AT&TBuzz enables you
to specify how and when the card associated with an incoming call
appears. You can select one of the following options for displaying the
associated card (via the Options item from the Setup menu):

— On Button Selection
Sets AT&TBuzz to display the associated card when you select
the Show Card button in the Tool bar or the Show Card option
from the Controls menu. If you perform either action, the
associated card appears.



Usi ng AT& TBuzz

— Automatically on Answer
Sets AT&TBuzz to display the associated card automatically after
you answer the call. As soon as you answer the call, the
associated card appears.

— Automatically on Ringing
Sets AT&TBuzz to display the associated card automatically while
the incoming call rings at your telephone. AT&TBuzz then takes
the caller ID, if available, and searches for a match in the
associated AT&TCall file. The associated card appears as soon
as a match is found.

= Export via Paste Link DDE
The Export via Paste Link DDE mode enables AT&TBuzz to export the
caller ID and the line label to another Windows application that supports
Paste Link DDE. In turn, AT&TBuzz may receive a string from that other
Windows application and use that string as a Call Label. Export via
Paste Link DDE mode requires that you write a macro in the other

application. Refer to for more information.

Regardless of the run mode you select AT&TBuzz also enables you to specify
whether or not you want to log incoming calls in the call log. This call log is the
same one used by AT&TCall. You can set AT&TBuzz to keep a record of
either all the incoming calls you receive, only those calls that you answer, or
not log any incoming calls. At any time, you can access the Log Viewer via
AT&TBuzz to view the call log.

To help you handle your incoming calls more quickly and easily, AT&TBuzz
enables you to set the following options:

= what should be done with the active call when you attempt to answer
another incoming call. You can manually select to place on hold or drop
the active call every time or you can set AT&TBuzz to either drop the
active call automatically or place the call on hold automatically.
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=  whether AT&TBuzz automatically inspects every incoming call that rings
at your telephone (that is, try to get caller ID). If you set AT&TBuzz to
automatically inspect every incoming call, you should always answer
calls directly from AT&TBuzz, instead of answering calls directly from
the telephone. If you answer calls directly from the telephone, you may
not be connected to the call selected in the AT&TBuzz window. You will
always be connected to the selected call when answering calls directly
from AT&TBuzz. This prevents you from interrupting an "inspection” in
progress and answering a call other than the one you are expecting to
answer.

= whether the AT&TBuzz window appears when your phone rings.

Using Caller 1D Information

Caller ID is call origination information (that is, the telephone number of the
telephone line from which the call is made) that may be delivered with an
incoming call. Whether or not an incoming, outside call has caller ID depends
on the telephone network. Unfortunately, all parts of the public telephone
network do not yet support caller ID. As a result, you may not be able to take
advantage of this feature yet. Caller ID is available on incoming, inside calls,
but the information provided depends on how your DEFINITY system is
administered.

You may receive the following information in the Caller ID field:

= the telephone number of the phone or telephone line from which the call
was made.

= the message "-Inspecting-," which indicates that the application is
inspecting the line for caller ID. You should not answer any calls directly

from the telephone if a call is in this state.
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= the message "Not Available,"” which indicates that the caller ID was
inspected successfully, and there is no caller ID information associated
with this call. This message could be caused by any of the following
circumstances:

— Caller ID is not available at your extension. This is probably the
case if all outside calls display the "Not Available" message.
Consult your System Manager.

— No caller ID was available from the telephone network.

If this column is blank, you may initiate an inspection of the caller ID if you
have an Inspect button programmed. To inspect for caller ID, select the record
in the list box and select the inspect button from the Tool bar.

If you are using AT&TBuzz in Match to AT&TCall File mode, it is important to
realize that the caller ID you receive from a caller does not always match the
telephone number that you may dial for that person. For example, suppose

you have a friend whose company has a telephone system with more than one
outside line. You know that this person’s phone number is 555-8888, and you
have this information in a card in the associated AT&TCall file. Since this
person’s company has more than one outside line, the caller ID for calls
coming out of that company can be different from the number you would dial to
call that company. When this person calls you, the caller ID you receive may
not match the number you dial to call this person. For example, this person
calls you, and the caller ID is 555-8889 (even though the telephone number
you dial for this person is 555-8888). AT&TBuzz will search all of the dialable
fields in the AT&TCall file to find a match. Since the caller ID for this call does
not match this person’s telephone number, AT&TCall will be unable to show
this person’s call label or card. In this example, you could help prevent this
situation from occurring by including this other caller ID in one of the dialable
fields in this person’s card. This way, when this person calls you again,
AT&TCall will be able to find a match.
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When running AT&TBuzz in Match to AT&TCall File mode, AT&TBuzz will
display "xxxx Matches" (where xxxx is the number of matches) in the Call
Label field if a dialable field in more than one card in your AT&TCall file
matches the caller ID of the incoming call. In this case, if you select the Show
Card button, the Multiple Matches dialog box appears, displaying the text from
the primary and secondary sort fields of each card that matches the caller ID.
You may then select and view one of these cards or create a new card. The
text from the primary and secondary sort fields for the card you selected
appears in the Call Label column of the AT&TBuzz window for the remainder
of this call.
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Running AT& TBuzz

In order to run AT&TBuzz, you must access Windows and open the program
group that contains the AT&T PassageWay applications. To run AT&TBuzz,
just double-click on the AT&TBuzz icon. The AT&TBuzz icon appears on the
bottom of your PC screen.

Helpful Hints

When using AT&TBuzz, keep in mind the following information:
= Answer all incoming calls via the AT&TBuzz window.

= |f you run AT&TBuzz in Match to AT&TCall File mode, you must update
your area code if it changes.
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Tasks

This section provides the tasks that you will perform while using AT&TBuzz.

Accessing the Log Viewer

To access the Log Viewer from AT&TBuzz:

1. Select Accessori es from the Controls menu.

A submenu appears.
2. Select Call Log.
The Log Viewer window appears.

For information on Log Viewer tasks, refer to|Chapter 6.

Answering a Call

If you do not have a speakerphone, perform the following steps:

1.  Select the call record of the call you want to answer in the call record
list box.

The selected call record is highlighted.

2. Select the Select button from the Tool bar.

A dialog box appears, instructing you to lift the handset.

3. Lift the handset of your phone.
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Shortcut:
1. Double-click on the call record of the call you want to answer.

2.  Lift the handset of your phone.

If you have a speakerphone, perform the following steps:

1. Select the call record of the call you want to answer in the call record
list box.

The selected call record is highlighted.

2. Select the Answer button from the Tool bar.

Shortcut:
Double-click on the call record of the call you want to answer.
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Changing the AT& TCall File Associated
with AT& TBuzz

You can change the AT&TCall file that is associated with AT&TBuzz while you
are running AT&TBuzz in Match to AT&TCall File mode.

[] NOTE:

You can only change the AT&TCall file associated with
AT&TBuzz when no calls are appearing at the phone.

To change the file:

1. Select Run Mode. .. from the Setup menu.

The Run Mode dialog box appears.

2. Click the mouse in the AT&TCall File box and enter the name of the file

that you want to associate with AT&TBuzz or use the Browse button to
display files.

3. When you are finished, select the OK button.

Creating a New Card in the Associated
AT&TCall File

When running in Match to AT&TCall File mode, AT&TBuzz enables you to add
a new card to the associated AT&TCall file. You can add a new card using
either the New Card button in the Tool bar or the New Card option in the
Controls menu. The New Card button is only available when the selected
incoming call does not already have an associated card in the AT&TCall file.
However, you can use the New Card option in the Controls menu to create a
new card at any time.
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To add a new card:

1. Select the call for which you want to create a new card in the
associated AT&TCall file.

The selected call record is highlighted.

2. Select the New Card button in the Tool bar or New Card from the
Control menu.

The AT&TCall New Card window appears. If there is caller ID
information in the currently selected call record, that information appears
in the bottom telephone number field in the card.

Exiting AT& TBuzz

To exit AT&TBuzz, select Exi t from the Setup menu.

Resetting the Size of the AT& TBuzz Window

As in other Windows applications, you can resize the AT&TBuzz window. For
example, if you want to view more than three call records (which is the default)
in the AT&TBuzz window, you can extend the size of the window vertically. If
some of the call labels exceed the call record list box and you want to view the
entire call label, you can extend the size of the AT&TBuzz window horizontally.
If you want the AT&TBuzz window to return to its default size and position,
select Reset Default W ndow from the Setup menu.

3-14



Using AT& TBuzz

Selecting a Call Record

In order to handle a call (for example, answer, hang up, or place on hold), you
must select the related call record in the call record list box. You can select
any call record by performing one of the following procedures:

= clicking on the call record in the call record list box

= using the arrow keys on the keyboard of your PC

The selected call record is highlighted.

Setting AT& TBuzz for Auto-Hold

You can set AT&TBuzz to automatically place on hold the current incoming call
and answer another incoming call when you select another call and then select
the Answer button. To set Auto-Hold:

1. SelectOptions... fromthe Setup menu.

The Options dialog box appears.
2.  Select the Auto-Hold First Call in the Answering Second Call group.
3. Select the OK button.

[] NOTE:
Auto-Hold only applies if you answer the call from the AT&TBuzz
window. If you answer the second call from the telephone, you
will drop the first call. Auto-Hold only applies if the first call is
incoming. If you place an outgoing call via AT&TCall and then
receive an incoming call, Auto-Hold will not apply.

If you want to be prompted for Hold or Drop on each attempt select the
Choose to Hold or Drop option in the Answering Second Call group.
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Setting AT& TBuzz for Auto-Drop

You can set AT&TBuzz to automatically drop the current incoming call and

answer another incoming call when you select another call and then select the
Answer button. To set Auto-Drop:

1. Select Options... fromthe Setup menu.

The Options dialog box appears.

2.  Select the Auto-Drop First Call in the Answering Second Call group.
3.  Select the OK button.

If you want to be prompted for Hold or Drop on each attempt, select the
Choose to Hold or Drop option in the Answering Second Call group.

Setting AT & TBuzz to Show the
Associated AT& TCall Card Automatically

When running in Match to AT&TCall File mode, AT&TBuzz enables you to
specify whether you want AT&TBuzz to display automatically the AT&TCall
card associated with the caller ID of the incoming call. If you want AT&TBuzz
to display the card automatically, you must then specify whether you want the
card to appear when the call rings at your telephone or when you answer the
call. If you do not want AT&TBuzz to automatically display the card, set the On
Button Selection option in the Options dialog box. You can then show the card

manually using the Show Card button in the Tool bar or the Show Card option
in the Controls menu.

To set when the AT&TCall card is displayed:

1. SelectOptions... fromthe Setup menu.

The Options dialog box appears.
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2.

3.

Select the appropriate option in the Show AT&TCall Card section of the
dialog box.

When you are finished, select the OK button.

Setting the AT & TBuzz Window to
Appear Automatically

You can set the AT&TBuzz window to be brought to the front or restored from
its icon automatically when a call rings. To set the AT&TBuzz window to

appear automatically when a call rings:

1.

Select Opti ons... from the Setup menu.

The Options dialog box appears.

Click on the Show AT&TBuzz on Ringing check box to enable or disable
the automatic appearance of the AT&TBuzz window when your
telephone rings. An "x" in the check box indicates that the AT&TBuzz
window will automatically appear when your telephone rings.

When you are finished, select the OK button.

Setting the Area Code

If you are running AT&TBuzz in Match to AT&TCall File mode, AT&TBuzz
requires the local area code. If your area code changes, you must update the
area code in AT&TBuzz. To change the area code:

1.

Select Options. . . fromthe Setup menu.

The Options dialog box appears.
Enter your area code in the Local Area Code field.

Select the OK button.
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Setting the AT& TBuzz Window to Always
be on Top of Other-Windows

AT&TBuzz enables you to specify that you want the AT&TBuzz window to be
located on top of all the other open windows, including the active window. To
specify that the AT&TBuzz window is always on top of other windows, select
Al ways on Top from the Setup menu. A check mark appears next to the
Always on Top option, indicating that the option is activated. The AT&TBuzz
window will now remain in front of all the other windows you open, even if it is
not the active window.

Setting Automatic I nspect Mode

AT&TBuzz enables you to specify whether you want to enable Automatic
Inspect Mode. If you enable Automatic Inspect Mode, AT&TBuzz automatically
inspects each call as soon as the call appears at the extension. When
Automatic Inspect Mode is disabled (which is the default), AT&TBuzz may only
receive caller ID for the first call that starts ringing at your telephone. If another
call rings at your telephone, you must select the call record for the call and
then select the Inspect button. If you enable Automatic Inspect Mode, you

should always answer calls from the application so that you do not interrupt the
inspect operation.

[1] NOTE:

Automatic Inspect Mode is disabled if you do not have Normal
and Inspect display feature buttons programmed on your
telephone.

To enable or disable Automatic Inspect Mode:

1. Select Options... from the Setup menu.

The Options dialog box appears.
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2.  Click on the Automatic Inspect Mode check box to enable or disable
Automatic Inspect Mode. An "x" in the check box indicates that

Automatic Inspect Mode is enabled.

3.  When you are finished, select the OK button.

Setting the Run Mode for AT& TBuzz

You can set AT&TBuzz to operate in one of the following three modes:

= No Matching, where AT&TBuzz displays the caller ID for each call (if
available), but does not display an associated Call Label.

= Match to AT&TCall File, which enables you to associate AT&TBuzz with
an AT&TCall file.

= Export via Paste Link DDE, which enables AT&TBuzz to export the
caller ID and the line label to another Windows application that supports
Paste Link DDE. In this mode, AT&TBuzz may receive a string from the
other Windows application and use that string as a Call Label.

[] NOTE:
You can change the run mode only when no calls are in the call

record list box.

To set the run mode:
1. Select Run Mode... from the Setup menu.

The Run Mode dialog box appears.
2.  Select the appropriate Run Mode option.

If you select the Match to AT&TCall File option, you must enter the path
and filename of the AT&TCall file that you want to associate with
AT&TBuzz.
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3.

Select the OK button.

When you select the Match to AT&TCall File option for the first time,
AT&TBuzz will prompt you to enter your area code.

Setting AT& TBuzz to Log Incoming Calls

AT&TBuzz enables you to specify whether you want incoming calls logged in
the Call Log. However, incoming call logging is only done while AT&TBuzz is

running. If you want incoming calls logged, you must then specify which calls.
You may select one of the following choices:

All Incoming Calls

When this option is selected, every incoming call is logged in the call
log.

Answered Calls Only

When this option is selected, only the incoming calls that you answer at
your extension are logged in the call log.

No Incoming Calls

When this option is selected, none of the incoming calls are logged in
the call log.

To set which incoming calls are logged in the call log:

1.
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Showing the Card of an Incoming Call
on Demand

When running in Match to AT&TCall File mode, AT&TBuzz enables you to
view on demand the associated card of an incoming call. However, you can
only perform this procedure if the caller ID for that call matches the contents of
a dialable number field of one or more cards in the associated AT&TCall file.
You can view the associated card using either the Show Card button in the
Tool bar of the AT&TBuzz window or the Show Card option from the Controls
menu. Both of these options are active if the caller ID of the incoming call
matches one or more cards.

To view the card associated with an incoming call:

1.  Select the call record whose card you want to view from the call record
list box.

The selected call record is highlighted.
2. Select the Show Card button from the Tool bar.

The associated card appears.

[] NOTE:
The Show Card button cannot be selected if the call does not
match a card in the associated AT&TCall file.
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Using the Timer

AT&TBuzz provides a stopwatch that enables you to time anything that you
want. You can use the Timer to time the length of a call, but you need to
manually start and stop the Timer. The Timer is not tied to the call.

To use the Timer:

1. Select Accessories from the Controls menu.

A submenu appears.

2. Select Ti ner.

The Timer window appears and immediately starts keeping time. The
Timer measures time in hours, minutes, and seconds. To reset the
Timer, select the Reset button. To stop the Timer, select the Stop
button. To restart the timer after it has been stopped, select the Start
button.

3. When you are finished using the Timer, select O ose from the Control-
menu box of the Timer window.
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AT&TBuzz Menu Bar Options

AT&TBuzz provides the following options in the menu bar:

= Setup
= [Controls
= |Help

This section describes the options contained in each AT&TBuzz menu.

Setup

The Setup menu contains the following options:
= Run Mode...
-

[Initialize Paste Link DDE|(only available when AT&TBuzz is running in
Export via Paste Link DDE mode)

[Reset Default Window|

IAlways on Top|
Exi

Run Mode...

Enables you to specify whether you want AT&TBuzz to display the caller ID for
each incoming call, search an associated AT&TCall file for a match, or export
the caller ID to another Windows application.
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Options...
Enables you to set the following options:

= Show AT&TCall Card (if AT&TBuzz is operating in Match to AT&TCall
File mode)

=  Answering Second Call

= Call Logging

= Automatic Inspect Mode

= Show AT&TBuzz on Ringing

= Local Area Code (if AT&TBuzz is operating in Match to AT&TCall File
mode)

Initialize Paste Link DDE

Initializes AT&TBuzz for exporting via Paste Link DDE. This option overwrites
the contents of the clipboard and is only available when AT&TBuzz is
operating in Export via Paste Link DDE mode.

Resat Default Window

Restores the AT&TBuzz window to its default size and position.

Always on Top

Keeps the AT&TBuzz window on top of all other open windows, including the
active window. This prevents the AT&TBuzz window from being obscured by
other windows.
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Exit
Closes the AT&TBuzz application.

Controls

The Controls menu contains the following options:
= Answer
= Hang Up
= Hold
=  Show Card
= |New Card

Accessories

Answer

Enables you to answer the selected call if it is ringing or on hold.

Hang Up

Enables you to hang up the selected call if it is active on your speakerphone.

Hold

Enables you to place the active call on hold.

Show Card

Enables you to view the associated AT&TCall card (if available) for the
selected call if a match exists in the associated AT&TCall file. This option is
only available when AT&TBuzz is operating in the Match to AT&TCall File
mode.
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New Card

Enables you to create a new card in the associated AT&TCall File. This option
is only available when AT&TBuzz is operating in the Match to AT&TCall File
mode.

Accessories

Enables you to access the Call Log and display the Timer.

Help

The Help menu contains the following options:
= Contents

= Search for Help on...

= |[How to Use Help|
= |About AT&TBuzz...|

Contents

Enables you to access the on-line Help.

Search for Help on...

Opens the Search dialog box for on-line Help. You can look up Help
information by entering keywords in the dialog box.
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How to Use Help

Describes how to use on-line Help.

About AT& TBUzz...

Displays the Windows version number, the AT&TBuzz version number, the
mode in which you are operating Windows, the amount of memory (KB)
available on your system, and the size of the largest contiguous block of
memory (KB) available.
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Overview

AT&TCall is a card file application that enables you to maintain information
such as names, addresses, and telephone numbers. You specify the
information that you want to store. With AT&TCall, you can place calls directly
from your PC and keep a log of calls you make from the application.

This chapter provides the following information:

[a description of AT&TCalll

[a tutorial describing how to use AT&TCall|

[helpful hints when using AT&TCalll

[the procedures for running AT&T Call|

[the tasks you will perform regularly while using AT&TCall|

la description of all the AT&TCall menu options|

4-1



Usi ng AT& TCall

W

Before using AT&TCall, you should consult the following sections of this
chapter:

= "What Is AT&TCall?,"” which describes AT&TCall and provides tasks that
you can perform with AT&TCall

» ['Getting Started,"|which is a tutorial that shows you how to use
AT&TCall

» |"Helpful Hints,"| which provides some "inside" tips and shortcuts that
maximize your time and effort when using AT&TCall

hat IsAT&TCall?

4-2

As mentioned previously, AT&TCall is a card file application. To understand
how AT&TCall operates, it is helpful to recall how a card file works. A card file
IS a unit that stores separate index cards, which are sorted according to
whatever method you want (usually alphabetical order) and contain specific
information you enter. When you obtain a new card file, it is usually empty.
You must then enter data on a card and add the card to the card file.
Eventually, the card file contains a "bank" of cards. If you want to modify a
card in the card file, you must find the card in the card file, remove it, make
your changes, and then place it back to its position in the bank. If you want to
delete a card, you must locate the card in the card file and remove it (usually,
you throw it away).

Each AT&TCall file can be thought of as being a separate card file unit. Each
AT&TCall file contains separate data entries, which are referred to as "cards."
The collection of these cards is referred to as a "bank." Each AT&TCall file can
contain a maximum of 2000 cards in its bank. These cards are sorted in
whatever manner you specify (via the Sort option in the View menu) and
contain specific information that you enter. shows an untitled
AT&TCall window displaying a blank card. shows the components
of an AT&TCall window.
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AT&TCall - (UNTITLED.DEX] %

i File Edit Yiew Setup Accessories Help
b Last l I5*
Fust 14
Tidle;
Company. [ l.} l
-~ r o .t
L&: M
Siae: I E
Home #:
Othes & E ,1 TN
Account #: Diaipad...
I “e-'—c‘dJ EB c_n_gis M3 Kljﬂip PERISGTLUVWXYZ38?

Figure 4-1. Untitled AT&TCall Window
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4-4

List Field

Card

File Name

Quick Dial

File Edit \
i B v I
E dwards Mary 4 Last|Remp Button
MorganJack Fast Dave _- E
Nplan,Paz _Tille: I E Label
Vs Company| ABC Travel E" Buffon
W] ||_Addess1010 Ocean Ave. 14
City:| Sea Bright Rl ]7|
Stater|NJ 14
Zip: l : IZI
_Office # I F
Home #: S
ﬁ Account #: Dialpad...
Edit Cad l Show Notes I © Yamer...
I 1
New Card M@LMNDFQR:TUVWYZO-S?
Previous Slider T_ Dial Next
Arrow Button Butfton Arrow Button

Figure 4-2. Components of an AT&TCall Window
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When you create a new AT&TCall file, it does not contain any cards. The List
field, which lists the cards present in the file, is empty, and the screen displays
a blank card. As with a card file, you must then access a new, blank card (via
the New Card button), enter data on the blank card, and add the new card to
the bank of the AT&TCall file (via the Add Card button).

If you want to modify a card in the AT&TCall file, you must find the card that
you wish to modify, remove it from the card bank, make your changes to the
card (via the Edit Card button), and then place it back in the bank (via the

Return Card button). If you want to delete a card, you must locate the card in

the AT&TCall file and delete it (via the Delete Card option in the Edit menu)
from the bank of the AT&TCall file. If you make changes that you want to save,
you must save the entire card bank to a file (via the Save or Save As options
in the File menu).

Unlike a card file, AT&TCall enables you to perform the following tasks quickly
and easily:

= place calls directly from a card
= sort cards in a AT&TCall file any way you want

= modify the card labels for all the cards in the AT&TCall file

= Kkeep track of all the calls you make
= include notes for each card

= implement passwords to prevent unauthorized use of your AT&TCall
files

Each AT&TCall file also provides a "desktop" with Quick Dials, which are
similar to autodial buttons on your telephone. AT&TCall provides a maximum
of 50 Quick Dials (two sets of 25) per file. However, if you need no more than
20 Quick Dials, you can set AT&TCall to display a maximum of 20 Quick Dials
(two sets of 10). AT&TCall also enables you to hide all of the cards in your
AT&TCall file. In this situation, only the Quick Dials, Hang Up button, Dialpad
button, Timer button, and Quick Shift button (if 50 Quick Dials are used) are
displayed.
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Depending on the number of Quick Dials you specified and whether the card is
hidden, your AT&TCall file desktop can have four different "looks." Figures 4-3,
4-4, 4-5, and 4-6 show these different desktop looks.

AT&TCall - BUSINESS.DEX

. M
al.Joh .
T | |b__Lesiwatensti
Schoeninger.Deni First{ Merissa [ David McKay Lﬂ
Shimko.Kenneth Thie: Glen Jeliiff |2I
g‘:rﬁfp;t:v:dd‘ Company]ABC Travel Jeanne Bayerl IZI
g*ﬂdleﬂ-eg Address! | Jodi Reichert | 2 |
tephens.Grei . -
Te:oomoa&d CitylMiddietown Ml& Ehnis IZI
Tharkar Nannie N . T =l
Tileman Ellen - State]NJ |_C. Santagato
Tomassoni,Dawn [ Zip] Steve Smith
Trejos.Femando Office 174322 [3‘ Home 31
Vmuez'tcle Wiliwie & 4 Bad e .u
Vidil Rich Home #]9.555-3344
Rang i
Other #] 30
Weard. Baerbara
Zelaski Liz Account Dialpad...

Edit Card l Shgw Notes l Timer...

New Card ABCDEFGH&JKLMNOPGRSTUVE(YZG-S?

Figure 4-3. Desktop with 10/20 Quick Dials and Card Shown
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File Edit
View Setup
Accessories
Help

[ Losi LaPiana [ 2]
|_Liz Zelaski .
| David McKay -

Glen Jelliff

Jodi Reichert

| P B |
|_Micky Ehnis ] 7]
I C. Sanla: ato .
[ Steve Smith [J]

Home

Hang Up

! Dialpad... I
E Tmer I

Figure 4-4. Desktop with 10/20 Quick Dials and Card Hidden
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gooc AT8TCall - BUSINESS DEX
File Edit !'ew Setup au:essoncs Help

Rohde.Charmeynd2 | Lori LaPiana ||| Rich Vidil 2l
[ PRy Sy | IGhI—\ :. r——‘—l—'l. n P ——— T =1
g::;z&o Carol R Walkenstein | Liz Zelaski Izl | Fermando | /|
: [ —————— ] [
ghdm_smnger?em Merissa |_Devid Mckey | 2| John Deutsch
eriden Adeie
Conith Oton
Somell Randal ABC Trave! ! Jeanne Bayerl IZI ] Chris Callins |Z|
Stadlerieo |__Jodi Reichert |Z” Bosco L]
Stephens.Greig |3 - T al = i
Tepoorten.Devid 1 Middletown I Miﬂ Ehnis IZI B. Ward
MheckerDeris N [ Seniageto | 7| [ Askinesi_|J]
i Moo o T al 1
TomassoniDawn [ |__Steve Smi ] EI ol
Trejos.Femando P T I [T 3
Valdez Edie 1432 i rnome [P4) menssa 4]
\fiedil Dk N T i |
"““&“;Meiame & §.555-3344 o

2
S EEE
H

Zeleskiliz a=>ollul 2 Dialpad... foBOORER__ )y}
_ | lahea & al l ’l

I 1% [11] lw’um I‘ I

EditCard | | _ShowNotes | P Timer.. [ Edie vaidez | 7]

NewCard | |, BCDEFGH I JKLMNOPGRSTU VMWK ¥283?

Figure 4-5. Desktop with 25/50 Quick Dials and Card Displayed
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T AT&TCall - BUSINESS.DEX
File Edit Yiew Setup
Accessories Help

Lori LaPiana Rich Vidil

‘ Liz Zelaski IZI Fernando I:I
[David McKay [ 2] [John Deutsch

|_Glen Jeliit IZ Lisa Ricker

[Jeanne ag;en]Z[ Chuis Collins -
! Jodi R@hm l Bosco I.jl
l Mickyp E hnis HIZi B. Ward JIZI
[c. Santagato [ [ M_Askinazi ]|
[Steve Smith [2][ Pat Nolan_[2]
[ Home E Mesizsa IZ

|
Hang Up I

Laubisch
Dialgad.-- ]7 Tepoorten

| John Roybal |.’f|
Timer. .. |_Edie Valdez .

I Quick Shift

Figure 4-6. Desktop with 25/50 Quick Dials and Card Hidden
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Getting Started

If you are using AT&TCall for the first time, it is a good idea for you to perform
the tutorial, which provides the basic procedures for using AT&TCall. This
tutorial takes approximately 15 minutes to complete and shows you how to
perform the following tasks:

1. [Run AT&TCall/
|Open an existing AT&TCall file.|

[Modify an existing card.|

[Create a new card.|

|[Enter notes for a card.|

[Make a telephone call from AT&TCall.|

[Save an existing file.|

[Create a new file.|

© © N o U R~ DN

[Customize the labels in a file.|

-
o

|Assign a telephone number to a Quick Dial.|

'_\
=

[Save a new file |

12. [Exit AT&TCall]

After completing this tutorial, you will have performed most of the basic
procedures necessary to use AT&TCall.

[] NOTE:

Make sure AT&TConnect is running. Otherwise, you will be
unable to place outgoing calls.
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Step 1. Running AT& TCall

Before you can perform any AT&TCall tasks, you must run AT&TCall. In order
to run AT&TCall, you must first access Windows and open the program group
that contains the PassageWay applications. To run AT&TCall, just double-click
on the AT&TCall icon. An untitled AT&TCall window appears, displaying a

blank card (Figure 4-7). shows the components of an AT&TCall
window.

o AT&TCall - [UNTITLED.DEX] 7]

File Edit Yiew Setup Accessories Help

&

> Last
Fus]
Title:
Company:
Address:
City:
State:

=

Home #:
Other 8
34 | Account #:

| e—e——— |

K
[ New Card | 3 COEFEHIJKIMNOBPERSTL ¥WXY 2087

Figure 4-7. Untitled AT&TCall Window
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List Field Card File Name Quick Dial

2 TC2 AMPLE .DEX
File Edit| Yiew Sectup Acc¢ssories Help
ATET Customd B 7
gg:ﬁiﬁgau b Lost/Kemp
% FistiDave -
Nglan,Pat Title:
e Company|ABC Travel
Y Address:| 1018 Ocean Ave.
City-{Sea Bright
State:|NJ
Zip:
Office #: :
Home 8: M
Other #:
= | Account &:
Edit Cacd ?\ | Show Notes |
Ney Card pﬁtﬁzjsﬁis%maamﬁs
Previous Slider _Dial Next
Arrow Button Button Arrow Button

Figure 4-8. Components of an AT&TCall Window

At this point you can either enter information into this new file (by adding new
cards) or open an existing file. For this tutorial, you will open an existing file.
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Step 2: Opening an Existing AT& TCall File

In this step, you will learn how to open an existing file by opening the file
"sample.dex." This file was copied to your PC when you installed the
PassageWay applications.

To open an exiting AT&TCall file, perform the following steps:

1. Select Open... from the File menu.

The Open dialog box appears.
2. Select sanpl e. dex from the File Name box and select the OK button.

The AT&TCall file titled "SAMPLE.DEX" appears. This file was copied to

your hard disk during the installation procedure. AT&TCall displays the
last state of the card bank. Whenever you open an existing AT&TCall
file, AT&TCall displays the last card that was displayed before you

saved and exited that file.
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Step 3. Editing an Existing Card

In this step, you will learn how to modify the information that is present in an
existing card (that is, a card that was already created and added to the card
bank).

The displayed card information cannot be modified directly. To make any
changes to this information, you must "edit" the card. However, before you can
edit an existing card, you must first locate the card in the bank. AT&TCall
provides several methods for selecting a card:

= clicking on the card in the List field

= clicking on the Next and Previous arrow buttons located on each side of
the Show Notes button

= clicking on the appropriate letter in the Slider, located at the bottom of
the AT&TCall window. For example, if the name you wanted started with
the letter "w," you could click on the "w" on the Slider. The first card that
began with the letter "w" would be selected and displayed.

To edit a card, perform the following steps:

1. Select the card "Kemp, Dave" from the card bank using one of the
methods described above.

The card for Dave Kemp appears.
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AT&TCall - SAMPLE DEX
Setup Accessories Help

File Edit View

Brown, Tom —
Edwards Ma b LastiKemp K

Morgan.Jack FastiDave <
Nolan P Tie:
R,'.j..(g'ME Cormnarrl ARC Tomeral f TA
V’O'-H'm WIE :z- ﬂu 3 IQVYCE l I“l
Address:| 1010 Ocean Ave. I la
City| Sea Bright | lg’

State:{NJ ;
Office &: Hr 1A

-

¥
Other 8 @ Hang o

| ,&! Account #: Dialpad...
l Edit Caed ' Show Notes I Tamer... ]
e —————— ieseee——

N N et |/ V

|_Nem Card | Ign CBEFGH! .;Ewuapsaswvwx'fza-g?

Figure 4-9. Card Display
2. Select the Edit Card button, which is located beneath the List field.

The Edit Card window appears and displays all of the information for the
selected card. The cursor is located in the top label field ("Last"), and
the name "Kemp" is highlighted. The Edit Card button removes the card
from the card bank, enabling you to modify the card.

[] NoOTE:
In the AT&TCall window, the Edit Card and New Card buttons are
"grayed" while you are editing or adding a card. Only one card
can be "out" of the card bank of an AT&TCall file at one time.

4-15



Using AT& TCall

e Edit Card %

L Lest? Kemp

Ftrsti Dave
Title:

Company: ABC Travel

Address:é‘l 010 Ocean Ave.
Cityi Sea Bright
StateiNJ

Zip:%
Office #
Home #*
Othert?

Account#.?

Return Card Cancel

Figure 4-10. Edit Card Window

You can move the cursor from field to field in the Edit Card window by
performing one of the following actions:
= pressing [ TAB ] or [ ENTER ] to move the cursor to the next field

= pressing [ sHIFT |—[ TAB ] or [ sHIET |—[ ENTER ] to move the cursor to the
previous field

= clicking the mouse on the field you want to select
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3. Using one of the methods described above, move the cursor to the
"Title:" field, and type Manager .

4. Using one of the methods described above, move the cursor to the
"Address:" field, delete 1010 OCcean Ave., andtype 204 Min
Street.

5. Using one of the methods described above, move the cursor to the
"City:" field, delete Sea Bri ght, andtype Asbury ParKk.

6. Select the Return Card button.

The Edit Card window disappears, and the changes you made are

displayed. The modified card for Dave Kemp is returned to the bank.

- AT&TCall - SAMPLE.DEX ]
File Edit View Setup Accessories Help
ATET Cuslomes [ d
Brown Tom v
E dwards Mar p LestiKemp
Morgan.Jack FictiDave
Nonpa TaelMansger —
oy e Company|ABC Travel I
Addess| 204 Main Sueet [ |
City-|Asbury Park I Ia
State:{NJ o
Zo: l [
Office #: %I I}l
Home #: [_—l
"~ ey g Hdng ,g!y
UNel & > ems—————
L isens
| New Card | Luz COEFGHI JE!LMHBF&B STLVWXYZIS?

Figure 4-11. Modified Card
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|

Step 4: Creating a New Card

In this step, you will learn how to create a new card, enter information into it,
and add the card to the bank.

To add a new card to the card bank, you must get a new, blank card, enter the
data in it, and then add the card to the bank. To add a new card to the card

bank, perform the following steps:
1. Select the New Card button.

The New Card window appears, and the cursor is located in the "Last:"
field. The contents of this window is a new, blank card.
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Edit

New Card

»

Last

First]

Title:

Company/

Address]

City,

State]

Zip:

Office #

Home #

Other #

Account #

Add Card

Cance]

Figure 4-12. New Card Window

2.
3.

Type Meyer .

Using one of the methods described previously, move the cursor to the

"First:" field, and type Fr ed.
Select the Add Card button.

The New Card window disappears, the labels for the new card appear
in the list field, and information for the new card is displayed. The new

card is now part of the card bank.
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S ATZTCall - SAMPLE.DEX E%

File Edit Yiew Setup Accessories Help .
AT&T Customer B 7 C 1A
Biown.Tom 1 al
E dwards Mary »_ Last:Meyer | i
SRR i e —
Magn oo .
NolanPat ! RS
Ricker M. et s | —
Vidi Rich Addess: C_ 14
Gy | 2]
State:! _ [ E|
= i
Office #: A
Home #:} E
: I Mang Un |
| B [ccomt®
EdeCard | <[\ [ Show Notes | /]
[ Negtad l ABCCEFS#1 JKILMNOPORSTUVWXYIRS?

Figure 4-13. New Card

Now, create a new card for someone you know in your office. When entering
information in the new card, be sure to include that person’s phone number in
either the Office #, Home #, or Other # field. Enter the phone number the
same way as you would when you are dialing it from your telephone. For
example, if you must enter a "9" before dialing the phone number, include a
"9" at the beginning of the phone number in the card.

When entering phone numbers in a card, you can also enter both numbers (for
example, 0-9) and alphabetic characters (for example, A-Z). For example,
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suppose a restaurant has the phone number 555-RIBS (which is 555-7427).
Instead of typing all seven numbers in the phone number field for this card,
you can enter 555-RIBS.

You can also enter *, #, (,), hyphens, spaces, commas, and periods in the
telephone number fields. A comma in a phone number inserts a 1 second
delay during the dialing process. You may want to include a comma after the
digit you use to access an outside line. AT&TCall ignores the other special
characters when dialing.

You will use this new card in Step 6. After creating this card, select the card
"Meyer, Fred" from the card bank, and proceed to Step 5.

Step 5: Entering Notes for a Card

In this step, you will learn how to enter notes for the card that you created in
Step 4.

AT&TCall enables you to enter notes for each card in a card bank. The Notes
field can contain up to 32K. When a card contains notes, the Notes icon
appears to the left of the Show Notes button. To enter notes for a card,
perform the following steps:

1. Select the Show Notes button.

The card display is replaced by a blank "note pad.”
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s AT&TCall - SAMPLE .DEX B
File Edit View Setup  Accessories Help
AT&T.D.BRWF&%

fsdie ot B8] fe 11}

Vidi.Rich

Edt Cord

N . g -

[NewCad | ancgss;—:a J:Lgnnm}ns HVWXYZES?

Figure 4-14. Note Pad

2. Selectlnsert Tinmestanp from the Edit menu.

The day, date, and time are inserted at the top of the note pad.
3. Type Must call tonorrow, and then selectthe Hide Notes button.
The card display replaces the note pad. The Notes icon appears to the

left of the Show Notes button, signifying that notes are present for this
card.
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ATE&TCall - SAMPLE.DEX

p Last|Mever
Fist_LFled
Title:
gﬁgﬁe. |_Company:
Vidi Rich Address
Gty
State:
Zp:
Office #:
Home #:
Othes 8:
4 | Account #:

[Eme] Q] b o]

i,
| Now Card | Escasrsm .;nuapcnsnsvwxvzs-s?

Figure 4-15. Card with Notes Icon

Step 6: Making Calls

In this step, you will learn how to make a call from the card you created in
Step 4 for someone you know and also make a call from the Dialpad.

AT&TCall provides the following ways for you to make phone calls while in a

file:
= [the Dial buttons on each card|
= [the Quick Dials in the AT&TCall window|

= [the Dialpad
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[] NOTE:
If you have a speakerphone, the AT&TCall window contains the Hang Up
button, which enables you to place your phone on hook (that is, hang up your
phone). If you do not have a speakerphone, the AT&TCall window contains the
Stop Dial button, which enables you to abort a call that you are in the process
of dialing.

From a Card

Making a phone call with a Dial button on a card consists of clicking on the
Dial button next to the phone number on the displayed card. To make a call
from a card, perform the following steps:

1. Select the card you created in Step 4.

The card appears.
2. Click on the Dial button next to that person’s phone number.
If you do not have a speakerphone, lift your handset. You hear dial

tone, and then AT&TCall places the call. (You can also place a call by
lifting the handset before clicking on the Dial button.)

If you have a speakerphone, your speakerphone activates, you hear dial
tone, and AT&TCall places the call.

3. Select the Hang Up button or hang up the handset to disconnect the
call.
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From a Quick Dial
Making a phone call with a Quick Dial consists of clicking on the Dial button of

a Quick Dial that you have already programmed with a telephone number. (If
you do not have a speakerphone, you must lift your handset.) This procedure

Is described in Step 10.

From the Dialpad

Making a phone call using the Dialpad feature is similar to dialing a phone
number from your telephone. To make a call from the Dialpad, perform the

following steps:
1. Select the Dialpad button.

The Dialpad Window appears.
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= Dialpad B
17 =
i 2 ki
26 Kl AR
1L ] L 5 wi L
a R REEss
7 g §
' 23
* ¢ o
Dial
Hang Up

Figure 4-16. Dialpad Window

At this point all of the buttons in the Dialpad window are disabled
except the Dial button. The Dialpad buttons become enabled when you
select the Dial button or go off hook (that is, lift your handset).

2. Select the Dial button.

If you do not have a speakerphone, lift your handset. You hear dial
tone.

If you have a speakerphone, the speakerphone activates, and you hear
dial tone.
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3. Using your PC keyboard or clicking on buttons in the Dialpad window,
enter a telephone number.

When entering the telephone number, make sure you enter the number
the same way as you would when you are dialing it from your
telephone. For example, if you must enter a "9" before dialing a
telephone number outside of your DEFINITY system (that is, an outside
call), enter a "9" in the beginning of the phone number.

AT&TCall passes each digit of the telephone number to the DEFINITY
system and places the call.

4.  Select the Hang Up button (if you have a speakerphone) or hang up the
handset to disconnect the call.

The telephone number you entered is automatically cleared from the
Dialpad display.

5. Close the Dialpad window by selecting close in the Control-menu box
of the Dialpad window.

Step 7: Saving an Existing File

In this step, you will leam how to save to the hard disk of your PC the changes
that you made to the existing file.

Now that you are done modifying the cards in the "sample.dex" file, you must

save your changes to disk. Select save from the File menu. This procedure
saves the changes you made to "sample.dex" to the hard disk of your PC.
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Step 8. Creating a New AT& TCall File

In this step, you will create a new AT&TCall file. New files are empty (that is,
they have no cards in the bank) and untitled. You will use this new file to learn
how to customize the labels of the card display in a file (Step 9).

To create a new AT&TCall file, select New from the File menu. An untitled,
empty AT&TCall file appears. This file is empty and displays a blank card.

Step 9: Customizing the Labels

In this step, you will learn how to customize the labels of the card display of
the new file you created in Step 8.

When you initially access a new AT&TCall file, AT&TCall displays the default
labels for the cards (for example, "Last," "First:," Title:," and "Company:").
However, you can change these labels at any time, enabling you to create
custom templates for the cards in your AT&TCall files. Whatever changes you
make to the labels apply only to the cards in the AT&TCall file in which you are
working. As a result, you can have AT&TCall files with different labels on their
cards. However, all the cards in the file have the same labels.
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To customize the labels, perform the following steps:

1. SelectEdit

Label s. ..

from the Setup menu.

The Edit Labels dialog box appears.

Edit Labels

The field labels for this AT&TCall file may
be customized using the edit boxes below:

Text Field 81:
Text Field 82:
Text Field 83:
Text Field #4:
Text Fieid £5:
Text Field 86:

Text Field 87: |S

Text Field 28: ]zp: |
Phone Field #1: Ig[hﬁg #: |

Phone Field £82:
Phone Field 8#3:
Account Code Field:

Last

Home &:

Other :

OK

Figure 4-17. Edit Labels Dialog Box

[]

NOTE:

The Account Code field is a text field similar to text fields 1 to 8.
The contents of this text field are not associated with the Account

Code feature on your DEFINITY system.
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2.  Using the methods described previously, move the cursor to Text Field
#7.

3. Delete State:, andenter Country:.
4.  Select the OK button.

The Edit Labels dialog box disappears, and the new field label is
displayed on the card template.

o AT&TCa D.O B
File Edit View Setup Accessories Help
b Lasti 14
Fust
Tae!
P I IR‘
] WIE L& l Rl
A 14
B
7 | Haag e |
———et———
Dialpad._.
[hemcae | Bocozronrs ELMNOPORS TBVWAYZD.3?

Figure 4-18. Modfied Card Labels
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Step 10: Programming a Quick Dial

In this step, you will learn how to program a Quick Dial in the new AT&TCall
file that you created.

AT&TCall enables you to program Quick Dials for each AT&TCall file. Quick
Dials consist of two components: a Label button and a Dial button. The Label
button displays information you want to be displayed on the button (for
example, the person’s name). The Dial button dials the phone number you
specified on the associated card. AT&TCall Quick Dials act the same way as
autodial buttons on your telephone.

The card bank in this new AT&TCall window is empty. Since a Quick Dial dials
a selected phone number from a specified card, you must create a card before
you can program a Quick Dial.

To create a card, perform the following steps:

1. Select the New Card button.

The New Card window appears.

2.  Fill out the card for someone you know. Make sure you enter a
telephone number for the person.

When entering the telephone number, make sure you enter the number
the same way as you would when you are dialing it from your
telephone. For example, if you must enter a "9" before dialing a
telephone number outside of your DEFINITY system (that is, an outside
call), enter a "9" in the beginning of the telephone number.

3. When finished, select the Add Card button.

The new card is displayed.
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After creating a card, you can program the phone number for that card to a
Quick Dial. To program a Quick Dial, perform the following steps:

1. Press and hold down [ sHIFT ] and click on a Label button of a Quick Dial.

Figure 4-19. Create Quick Dial Dialog Box
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The Create Quick Dial dialog box appears, displaying the label that will
appear on the Quick Dial Label button and the telephone number that
the Quick Dial will dial. You may modify the label to make it more
descriptive to you and select the option button of the phone number that
you want this Quick Dial to dial (if more than one telephone number is

available).

To create a Quick Dial button for
"Ricker,Lisa"

~ Label

Enter the label that will
appear on the button:

Label: |Ricker.Lisa

~ Numbes

Select which phone number will be
dialed by this button:

P TS s s TIPS @ e N
@ Ulthce 8. 3,.303-1Z21<Z
O Home #: 9.555-3521

O gher

OK
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When programming Quick Dials, you may want to modify the labels. For
example, suppose you want to program a Quick Dial for a friend’s office
telephone number, and also program a Quick Dial for that person’s
home telephone number. If you do not modify the Label buttons when
programming these Quick Dials, you will have two Quick Dials that have
the same labels, but dial different telephone numbers. By looking at the
Label buttons of these Quick Dials, you will be unable to determine
which Quick Dial dials the office telephone number, and which Quick
Dial dials the home telephone number. In this case, it would make
sense to include terms such as "Home" or "Office" in the labels to
differentiate what each of the Quick Dials will dial.

When finished, select the OK button.

The Create Quick Dial dialog box closes, and the label appears on the
Label button of the Quick Dial.

To make a call from this Quick Dial, perform the following steps:

1.

Click on the Dial button of the Quick Dial that you just programmed.

If you do not have a speakerphone, lift your handset. You hear dial
tone, and then AT&TCall places the call. (You can also place a call by
lifting the handset before clicking on the Dial button.)

If you have a speakerphone, your speakerphone activates, you hear dial
tone, and AT&TCall places the call.

Select the Hang Up button or hang up the handset to disconnect the
call.
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Step 11: Saving a New File

In this step, you will learn how to save the new file to the hard disk of your PC.

To save this new file to disk, perform the following steps:

1. Select Save As. . . from the file menu.

The Save As dialog box appears.

2. Entertrial inthe File Name box.

[] NOTE:

AT&TCall automatically adds the ".dex" suffix to the file name you
enter. If you prefer, you may enter another suffix. However, it is
recommended that you use the ".dex" default to make it easier to
identify and load AT&TCall files.

3. Select the OK button.

The Save As dialog box disappears, and "AT&TCall-TRIAL.DEX"
appears in the title bar of the AT&TCall window.

Step 12: Exiting AT& TCall

Now that you have completed the AT&TCall tutorial, exit AT&TCall. To exit
AT&TCall, select Exit from the File menu. The AT&TCall window closes.

4-34



Using AT&TCall

Helpful Hints

Once you have completed the tutorial, refer to the following hints:

»  Keep all AT&TCall files in the same directory.

By default, AT&TCall saves and opens files from the directory in which
the PassageWay applications are installed. By keeping all the AT&TCall
files in the same directory, you can easily access your files.

= Determine whether you need more than 20 Quick Dials.

AT&TCall enables you to program a maximum of 50 Quick Dials (two
sets of 25, which are accessed via either the Quick Shift button or the
Quick Shift option in the View menu). However, if you need no more
than 20 Quick Dials, you can set AT&TCall to display a maximum of 20
Quick Dials (two sets of 10, which are accessed via the Quick shift
option in the View menu). See ['Changing the Number of Quick Dials|

described later in this chapter.

= Administer a password for your AT&TCall files.

To prevent unauthorized individuals from accessing your files,
administer passwords for your AT&TCall files. See ['Protecting an|
IAT&TCall File with a Password,"| described later in this chapter.
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Running AT& TCall

In order to run AT&TCall, you must access Windows and open the program
group that contains the PassageWay applications. To run AT&TCall, just
double-click on the AT&TCall icon. Either an untitled AT&TCall file appears, or
an existing AT&TCall file is automatically loaded. (See ['Specifying an|
IAT&TCall File to be Loaded Automatically,"|described later in this chapter, to
set AT&TCall to load a specific file automatically.) Refer to the following
section describing the tasks that you will perform regularly while using
AT&TCall.

Tasks

This section provides the tasks that you will perform while using AT&TCall.
These tasks are grouped into the following categories:

= file tasks

.
= |Quick Dial tasks|

File Tasks

This section describes the tasks that you will perform when working in an
AT&TCall file.
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Accessing the Log Viewer

To access the Log Viewer from AT&TCall, select Cal | Log from the
Accessories menu. The Log Viewer window appears.

[] NOTE:
For more information on Log Viewer tasks, refer to [Chapter 5.

Changing How Cards are Sorted in an AT& TCall File

AT&TCall enables you to change the order in which cards are organized in the
card bank. To change how cards are sorted in your AT&TCall file:

1. SelectSort... from the View menu.

The Sort dialog box appears.

Sort

Select the fields that will be used to
organize your card bank. "First" will be
used as most important when the cards in
your card bank are sorted.

Fust: |Last

Second:

Figure 4-20. Sort Dialog Box

2.  Select the First box, and select the label of the field that you want
AT&TCall to sort by first.
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3. Select the Second box, and select the label of the field that you want
AT&TCall to sort by second.

4. Select the OK button.

The Sort dialog box disappears, and the cards are now sorted in the
card bank according to your specifications.

Creating a File Template

AT&TCall enables you to create a template for all new AT&TCall files that you
open. Once you create a template, all of your new AT&TCall files will have the
attributes (for example, specific labels or the number of Quick Dials that you
want displayed) that you specified in the template. For example, suppose you
want 25 Quick Dials, a card with your home phone number, and the first Quick
Dial programmed with your home phone number in every file that you create. If
you specify these attributes in your template, every new file that you create will
automatically have 25 Quick Dials, a card with your home phone number, and
the first Quick Dial programmed with your home phone number. At any time,
you can modify or delete this file.

To create a template:

1. Select New from the File menu.

A new, untitled AT&TCall window appears.

2.  Customize the file to your specifications. For example, modify the labels,
add any cards that you want to appear in all of your new AT&TCall files,
and specify the number of Quick Dials you want in all of your new
AT&TCall files.

3.  When you are finished, select Save As... from the File menu.

The Save As dialog box appears.
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4. Enterattcall.tpl inthe Filename box and select the OK button.

The template is now saved. Every new file you open will now contain
the attributes that you specified in your template.

Creating a New AT& TCall File
To create a new AT&TCall file:

1. Select New from the File menu.

A new, empty AT&TCall file with the title "(UNTITLED.DEX)" appears.
When you save this file, AT&TCall will prompt you to name the file.

2. Enter your information in this file.

3. When you are finished working and want to save this file, select Save
As. .. from the File menu.

AT&TCall prompts you to name this file.

4.  Enter the file name in the File Name box, and then select the OK
button.

The name of the file appears in the title bar of the window.

Dialing a Phone Number with the Dialpad
To dial a phone number with the Dialpad:

1. Select the Dialpad button.

The Dialpad window appears.
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2. Select the Dial button.

If you do not have a speakerphone, lift your handset. Your hear dial
tone.

If you have a speakerphone, your speakerphone activates, and you
hear dial tone.

3. Using your PC keyboard or clicking on buttons in the Dialpad window,
enter the phone number.

When entering the telephone number, make sure you enter the number
the same way as you would when you are dialing it from your
telephone. For example, if you must enter a "9" before dialing a
telephone number that is outside of your DEFINITY system (that is, an
outside call), enter a "9" in the beginning of the telephone number.

AT&TCall passes each digit of the telephone number to the DEFINITY
system and places the call.

4. When the call is completed, select the Hang Up button (if you have a
speakerphone) or hang up the handset to place your telephone on
hook.

The telephone number you entered is cleared from the Dialpad display.

5.  Close the Dialpad window by selecting O ose in the Control-menu box
of the Dialpad window.

Exiting AT& TCall
To exit AT&TCall, select Exi t from the File menu.
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Exporting AT& TCall Information

AT&TCall enables you to export a single card or an entire AT&TCall file to a
file in the comma separated values format (".csv"), which can be used in other
applications. During the export procedure, AT&TCall takes the 12 fields on a
card and the associated Notes field and writes them out in a horizontal line in
a ".csv" file. This line of information from a card is referred to as a "record."” If
you export an AT&TCall file that has 20 cards, the ".csv" file will have 20
records.

[] NOTE:
All alphabetic characters that appear in the telephone number
fields are converted to digits.

To export an AT&TCall file or card:

1. Open the file that has the information you want to export

The AT&TCall window appears.

[] NOTE:
If you only want to export one card, select that card in the bank.

2. Select Export from the File menu.

A submenu appears.

3. SelectAll Cards... ifyouwantto exportthe entire AT&TCall file, or
Select Current Card. .. if youwantto exportthe currently displayed
card.

The Export dialog box appears.
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Figure 4-21. Export Dialog Box

4.  Enter the name of the file to which you want to save this information
and select the OK button.

The Export dialog box closes, and the new file is created.

Importing Files into AT& TCall

AT&TCall enables you to import files that were created in other applications.
To be imported by AT&TCall, these files must be in the comma separated
values format (".csv"). A ".csv" file consists of "records," which are horizontal
fields of data. Each field of data is separated from the next field by a comma
(,). Fields containing commas and/or fields consisting of more than one line
must be surrounded by quotes (" "). Each record is one group of related data.
The end of each record is signified by a carriage return. A ".csv" file can have
numerous fields in a record. However, AT&TCall will only import 13 fields of

data from each record in a ".csv" file. Three records in a ".csv" file may look
like this:

Nol an, Pat, "ABC Travel, Inc."

Ri cker, Lisa, "ABC Travel, Inc. "
Vidil, Rich, "ABC Travel, Inc."
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AT&TCall imports 13 horizontal data fields from the ".csv" file, and then places
the information in the 13 vertical fields of a card in an AT&TCall file (that is, the
12 card fields and the Notes field). If there are more than 13 fields of data in a
record, AT&TCall ignores the remaining data in that record and proceeds to
the next record. If there are less than 13 fields of data in a record, AT&TCall
assumes that the remaining fields in the record are blank and proceeds to the
next record. For example, if each record only contained two fields of
information, AT&TCall would place the information in the first two fields in a
card (for example, the "Last" and "First" label fields) and make the remaining
fields in that card blank. It would then proceed to a new card and enter the
information for the next record.

During the import procedure, AT&TCall scans the file to be imported, verifying
that the file is valid (that is, it is in the correct format) and that only numeric
characters will reside in the telephone number fields (that is, the ninth, tenth,
and eleventh fields) in a card in an AT&TCall file. The telephone number fields
in a card accept all numeric digits, *, #,(,), hyphens, spaces, commas, and
periods.

[1 NOTE:
Even though AT&TCall enables you to enter alphabetic
characters in the telephone number fields of an AT&TCall card,
AT&TCall does not import alphabetic characters into the
telephone number fields. In addition, if the contents of a field
exceeds the number of characters that can be displayed in the
card, the contents of the field will be truncated (that is, the excess

data is lost).

To import a file:

1. Open the AT&TCall file in which you want the imported data to reside.

The AT&TCall file window appears.
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[] NOTE:
If you are, importing data into an existing AT&TCall file, the new
data will be sorted automatically as it is imported. As a result, this
new information will be "mixed in" with your existing information.

2. Selectlnport... from the File menu.

The Import dialog box appears.

List Files of T ppe: Drves:

l {CSV Files[~.CSV) [8] |#8 c dosbbncs [3] J

Figure 4-22. Import Dialog Box

3. Select the file that you want to import and select the OK button.
AT&TCall scans the file and then imports the records from the file (if the

file is valid). A dialog box appears, stating the number of cards (that is,
records) that were imported from the ".csv" file.
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] AT&TCall

0 47 cards(s) have been imported successfully.

OK

Figure 4-23. AT&TCall Dialog Box

4, Select the OK button.

The dialog box closes, and the new information is displayed in the
AT&TCall window.

Opening an Existing AT& TCall File
To open an existing AT&TCall file:
1. Select Open... from the File menu.
The Open dialog box appears, showing a list of the available ".dex" files
in the current directory and disk drive.

2.  Select the AT&TCall file you want from the File Name box, and select
the OK button. You may use the drive and directory controls to switch
drives and/or directories.

The file is loaded, and AT&TCall displays the last state of the card bank.
Whenever you open an existing AT&TCall file, AT&TCall displays the
last card that was displayed before you saved and exited that file.
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Printing a Card List

AT&TCall enables you to print a list of the cards in an AT&TCall file. You may
specify the labels of the information that you want printed for each card. For
example, if you want the list to contain the last name, first name, and office #
for each card in the file, you must specify these labels in the Print List dialog

box. In this example, one field would contain "Last:," one field would contain
"First:," one field would contain "Office #:," and the three remaining fields

would each contain "(None)." "(None)" signifies that no label was selected and
that no information will be printed in this field. You may select up to six labels
whose information you want printed.

To print a list of the cards in an AT&TCall file:

1. Select Print List... from the File menu.

The Print List dialog box appears.

Piinter: HP Lasesdlet lIIP PostScript on LPT1:

Select fields to print

[Last [3] [Frst_ [3] [Nomel  [3] [iNone]  T#] [iNone]  [#] [Mone)  [2]
[ ox ] | conce Setup...
| SIINENNNNNNNNNN————————

Figure 4-24. Print List Dialog Box

2. In each field, select the label of the information that you want printed for
each card.

3. When finished, select the OK button.

Printing begins, and a dialog box is displayed, which enables you to
cancel printing.
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Printing an AT& TCall Fileor Card

AT&TCall enables you to print either all of the cards in an AT&TCall file or only
the card that is currently displayed. When printing a file or card, you may
specify whether you want the notes associated with the card(s) displayed. If
you specify that you want the notes displayed, AT&TCall will print out each
card and its notes on its own page. The top of each page will contain the label
for the card, and the bottom of each page will contain the date, page number,
and file name.

If you specify that you do not want the notes displayed, AT&TCall will print out
four cards on each page. The top of each page will contain the labels for the
first and last cards on the page. The bottom of the page will contain the date,

page number, and file name. [Figure 4-25|shows how the cards look with and
without the notes printed.
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Figure 4-25. Printed Cards With and Without the Notes
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To print an AT&TCall file or card:

1. SelectPrint Cards... from the File menu.

The Print Cards dialog box appears.

B PrintCards |

Printer: HP Laserlet HIIP PostScript on LP

[ Range O Print Notes
©® Cunrent Caed | — =
O Al Cards setup...
oK Cancel

Figure 4-26. Print Cards Dialog Box

2.  Perform one of the following steps:

— If you want to print the card that is displayed currently, select the
option button for Current Card.

— If you want to print all the cards in the file, select the option
button for All Cards.

3. Select the Print Notes box if you want to print the notes associated with
the card(s).

4. When finished, select the OK button.

Printing begins, and a dialog box is displayed, which enables you to
cancel printing.
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Protecting an AT& TCall File with a Password

AT&TCall enables you to administer a password for each file, preventing
unauthorized people from accessing the file. Passwords may consist of up to
eight printable characters (that is, letters, numbers, and punctuation marks)
and are case sensitive (that is, AT&TCall can differentiate between capital
letters and lowercase letters). After a password is administered for a file,
AT&TCall prompts you to enter a password every time you attempt to access
that file. You may administer passwords for as many AT&TCall files as you

like.

To administer a password for an AT&TCall file:

1. Select Save As... from the File menu.

The Save As dialog box appears.

2. Select the Password button.

The Password Dialog box appears.

Password

Enter Password

——————eesese—————————

Figure 4-27. Password Dialog Box

3.  Enter your password and select the OK button.

The Confirm Password dialog box appears.
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Confirm Password

Re-enter Password:

_
Figure 4-28. Confirm Password Dialog Box
4. Re-enter your password and select the OK button.

5. Select the OK button.

The next time you attempt to open this file, AT&TCall will prompt you for
the password.

Removing the Password from an AT& TCall File
To remove the password from an AT&TCall file:

1. Open the AT&TCall file whose password you want to remove.

The file is loaded.

2. Select Save As. . . from the File menu.

The Save As dialog box appears.

3. Select the Password button.

The Password Dialog box appears.

4. Delete the password from the Enter Password field and select the OK
button.
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5. Select the OK button.

The next time you attempt to open this file, AT&TCall will not prompt
you for the password.

Saving an AT& TCall File

To save any changes to an existing AT&TCall file, select Save from the File
menu. If the file is new, and has not been saved yet, select Save As... from
the File menu.

[1 NOTE:
AT&TCall automatically adds the ".dex" suffix to the file name you enter. If you
prefer, you may enter another suffix. However, it is recommended that you use
the ".dex" default to make it easier to identify and load AT&TCall files.

Setting the AT& TCall Window To Always Be on Top of Other
Windows

AT&TCall enables you to specify that you want the AT&TCall window to be
located on top (that is, in front) of all the other open windows, including the
active window. This option is especially useful when you are using AT&TCall in
the Card Hidden mode and want to keep a set of programmed Quick Dials
readily accessible.

To specify that the AT&TCall window is always on top of other windows, select
Al ways on Top from the Setup menu. A check mark appears next to the
Always on Top option, indicating that the option is activated. The AT&TCall
window will now remain in front of all the other windows you open, even if it is
not the active window.
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Setting the Dial Options

AT&TCall enables you to specify a prefix and/or suffix that AT&TCall will add
to all telephone numbers dialed via Dial buttons in the associated AT&TCall
file. For example, if you must enter a "9" before dialing a telephone number
outside of your DEFINITY Communications System (that is, an outside call),
you can specify the prefix "9" in the Dial Option dialog box. However, if you
specify a Dial Option, AT&TCall will use that option for each and every call you
initiate from any Dial button in that AT&TCall file. Therefore, if you use Dial
Options, make sure all of the telephone numbers in all of the cards in that
AT&TCall file require the same Dial Option.

To set Dial Options:

1. SelectDial Options... fromthe Setup menu.

The Dial Options dialog box appears.

Dial Options

Digits entered in the fields below will be dialed
before or after all outside (non-intercom) calls
placed from this card file.

O Before:
[0 Atter:

0K

Figure 4-29. Dial Options Dialog Box

2. Select Prefix and/or Suffix, depending on your requirements.

The box next to the option you selected is checked.
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3.
4.

In the field next to the option you selected, type the prefix or suffix.

Select the OK button.

The Dial Options dialog box disappears.

Specifying an AT& TCall File To Be Loaded Automatically

AT&TCall enables you to specify a file that will be loaded automatically every
time you access AT&TCall. To specify a file to be loaded automatically:
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2.
3.

Exit AT&TCall.
Locate the AT&T PassageWay group window in Program Manager.

Select the AT&TCall icon with a single click.

The AT&TCall icon is highlighted.

Select Properties... from the File menu of Program Manager.

The Program Item Properties dialog box appears.
Place the cursor in the Command Line box.

Move the cursor to the end of the Command Line box, after
attcall . exe.

Press the spacebar on your keyboard, and then enter the name and
extension of the AT&TCall file that you want to be loaded automatically.
If the file does not reside in the same directory as AT&TCall, you must
specify the path in front of the file name.
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[] NOTE:
You must include . dex at the end of the file name. Otherwise,

AT&TCall will be unable to load this file automatically.

Figure 4-30 shows how the Program Item Properties dialog box would
look if you set the "sample.dex" file to be loaded automatically.

Program Item Properties

Description: [aTeTCaN J1 ox ]

Command Line: PWDEF\attcall exe sampie.dex
Warking Daectory: IC:WDEF

Change lcon. ..

[0 Bun Minimized

Scaker e ,

Figure 4-30. Sample File to be Loaded Automatically

8. Select the OK button.

The Program Item Properties dialog box closes. The next time you
access AT&TCall, the file you specified will be automatically loaded.
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Card Tasks

This section describes the tasks that you will perform when working on cards
in an AT&TCall file.
Accessing the Notes Field

AT&TCall enables you to maintain notes for each card. The Notes icon
appears to the left of the Notes button when the card has information in the

Notes field. The Notes field can contain up to 32K. To access the Notes field
for a card:

1. Select the card of which you want to access the Notes field.

The selected card appears.

2. Select the Show Notes button.

The Notes field appears.

3. Enter information in the Notes field or modify the existing information (if
any) in the field.

4.  When you are finished, select the Hide Notes button.

The card is displayed.

Changing the Field Labels in the Cards

AT&TCall enables you to change the field labels for the cards in the bank. This
only applies to the bank you are in. To change the field labels:

1. SelectEdit Labels... from the Setup menu.

The Edit Labels dialog box appears.

2. Make your changes.
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3. When you are finished, select the OK button.

The Edit Labels dialog box disappears, and your changes are displayed
on the card.

Creating a New Card
To create a new card:
1. Select the New Card button.

The New Card window appears, and the cursor is located in the first
field.

2. Enter the appropriate information in each field that you use.

3. When you are finished entering information in this card, select the Add
Card button.

The New Card window closes, the labels for the new card appear in List
field, and the information for the new card is displayed.

Deleting a Card

To delete a card:

[] NoTE:
When you delete an existing card, all Quick Dials associated with

that card are deleted.

1. Select the card you want to delete.

The selected card is displayed.
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2. Select Del ete Card from the Edit menu.

The Delete Card dialog box appears.

Delete Card

Delete this card?

NOTE: all Quick Dial buttons associated with the

card will be erased!

OK Cancel

Figure 4-31. Delete Card Dialog Box
3.  Select the OK button.

The card is deleted from the bank, and the next card in the bank is
displayed.

Dialing a Phone Number from a Card
To dial a phone number from a card:

1. Select the card that contains the phone number you want to dial.

The selected card is displayed.
2.  Click on the Dial button located to the right of the phone number that
you want to dial.

If you do not have a speakerphone, lift your handset. You hear dial
tone, and then AT&TCall places the call. (You can also place a call by
lifting the handset before clicking on the Dial button.)
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If you have a speakerphone, your speakerphone activates, you hear dial
tone, and AT&TCall places the call.

After the call is completed, select the Hang Up button (if you have a
speakerphone) or hang up your handset to place your telephone on
hook.

Editing an Existing Card

To edit an existing card:

1.

Select the card you want to edit.

The card is displayed.
Select the Edit Card button.

The Edit Card window appears containing the current information for the
card.

Make your changes to the card.

When you are finished, select the Return Card button.

The Edit Card window closes, and the updated card is displayed.
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Hiding the Card Display

AT&TCall enables you to hide the card display and view only the Quick Dials,
the Hang Up button, the Dialpad button, the Timer button, and the Quick Shift
button (if the 25/50 Quick Dial Buttons option is selected). To hide the card
display, select H de Card from the View menu.

Selecting a Card

You can select any card in the AT&TCall file by performing one of the following
steps:

= clicking on the entry in the List field

= clicking on the Next and Previous arrow buttons that are located on
each side of the Show Notes button

= clicking on a letter on the Slider

= using the Fi nd and Fi nd Next options from the Edit menu, and the
Next Card, Prev Card, Next Letter, andPrev Letter options
from the View menu

Showing the Card Display
To show the card display after hiding it via the Hide Card option in the View
menu, select Show Card from the View menu.

Using the Timer

AT&TCall provides a stopwatch that enables you to time anything that you
want. You can use the Timer to time the length of a call, but you need to
manually start and stop the Timer. The Timer is not tied to the call.

4-60



Us ng AT& TCall

To use the Timer:
1. When you want to start the timer, select the Timer button.

The Timer window appears and immediately starts keeping time. The
Timer measures time in hours, minutes, and seconds. To reset the
timer, select the Reset button. To stop the timer, select the Stop button.
To restart the timer after it has been stopped, select the Start button.

hours:mins:secs
00:00:17
Start | St Reset

Figure 4-32. Timer
Window

2.  When you are finished using the timer, select O ose from the Control-
menu box of the Timer window.

Quick Dial Tasks

This section describes the tasks you will perform when using Quick Dials in an
AT&TCall file.

Accessing Information for a Quick Dial

To view the information for a Quick Dial:

1. Press and hold down [ sHIFT ], and then click on the Dial button of the
Quick Dial in which you are interested.

The Quick Dial Information dialog box appears. This dialog box presents
the label and phone number for this Quick Dial.
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Quick Dial Information

This button dials from card
"Ricker,Lisa"

Label: Lisa Ricker

Number: 9,555-1212

l oK l

Figure 4-33. Quick Dial Information Dialog
Box

2.  When you are finished, select the OK button.

If you want to display the card associated with the Quick Dial, click on the
Label button of the Quick Dial in which you are interested. The associated card
is displayed.
Assigning a Phone Number to a Quick Dial
To assign a phone number to a Quick Dial:
1. Select the card that contains the telephone number that you want to
program to a Quick Dial.
The selected card is displayed.
2.  Press and hold down [ sHiFT ], and then click on the Label button of the

Quick Dial that you want to program.

The Create Quick Dial dialog box appears. AT&TCall provides a default
label.
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Create Quick Dial

To create a Quick Dial button for
"Ricker,Lisa"

~ Label
Enter the label that wiil
appear on the button:

Labet: |Ricker Lisa

- Number

Select which phone number will be
dialed by thiz button:

@ Office 8: 8.555-1212
O Home #: 9.555-3521
C Strer &

OK

Figure 4-34. Create Quick Dial Dialog
Box

3. Enter the label that you want to appear on the Label button of the Quick
Dial.

4. Select the option button of the telephone number that you want this
Quick Dial to dial.

5. Select the OK button.

The label you entered appears on the Label button of the Quick Dial
you selected.
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Changing the Number of Quick Dials Displayed

AT&TCall allows you to program a maximum of 50 Quick Dials (two sets of 25,
which are accessed via either the Quick Shift button or the Quick Shift option
in the View menu). However, if you need no more than 20 Quick Dials, you
can set AT&TCall to display a maximum of 20 Quick Dials (two sets of 10,
which are accessed via the Quick Shift option in the View menu).

To specify the number of Quick Dials you want to access, select either
10/20 Quick Dial Buttons or25/50 Quick Dial Buttons from the
Setup menu.

Changing the Setup of the Quick Dial Labels

AT&TCall enables you to display the information on the label buttons of Quick
Dials as left-justified or centered. This setting applies to all AT&TCall files. To
change the setup of the information on the Label buttons of Quick Dials:

1. Select Quick Di al Labels... from the Setup menu.

The Quick Dial Label Setup dialog box appears.
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= Quick Dial Label Setup

The labels appearing on Quick Dial
buttons may be left-justified or centered.
Use the option buttons below to indicate
your preference.

O Left-Justify Quick Dial Labels
@ Center Quick Dial Labels

oK

Figure 4-35. Quick Dial Label Setup Dialog

Box

2.  Select the option button for the setup you want.
3.  Select the OK button.

Dialing a Phone Number from a Quick Dial

To dial a phone number from a Quick Dial, click on the Dial button of the
Quick Dial in which you are interested.

Cancel

If you do not have a speakerphone, lift your handset. You hear dial tone, and

then AT&TCall places the call. (You can also place a call by lifting the handset
before clicking on the Dial button.)

If you have a speakerphone, your speakerphone activates, you hear dial tone,
and AT&TCall places the call.

After the call is completed, select the Hang Up button (if you have a
speakerphone) or hang up your handset to place your phone on hook.
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Erasing a Quick Dial

To erase the label and telephone number assigned to a Quick Dial:

1.

Press and hold down [ sHIFT ], and then click on the Label button of the
Quick Dial that you want to erase.

The Change Quick Dial dialog box appears.

Select the Erase button.

The information for that Quick Dial is erased, and the Label button for
the Quick Dial is blank.

Re-Assigning an Existing Quick Dial
To assign a phone number to a Quick Dial that has been assigned previously:

1.
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Select the card that contains the telephone number that you want to
program to the Quick Dial.

The card is displayed.

Press and hold down [ sHIFT ], and then click on the Label button of the
Quick Dial that you want to change.

The Change Quick Dial dialog box appears.
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Change Quick Dial
This Quick Dial button is currently assigned.

Fi

3.

Select "Create New" to reassign the button to
one of the numbers on the currently displayed
card.

Select "Erase" to erase the contents of the

button without reassigning it. This option will
leave the button blank.

Select "Cancel" to leave the button unchanged.

Create New Erase Cancel

R

gure 4-36. Change Quick Dial Dialog Box

Select the Create New button.

The Create Quick Dial dialog box appears.

Enter the label that you want to appear on the label button of the Quick
Dial.

5.  Select the option button of the telephone number that you want this

Quick Dial to dial.

6. Select the OK button.

The label you entered appears on the Label button of the Quick Dial
you selected.
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AT& TCall Menu Bar Options

AT&TCall provides the following options in the menu bar:

s File

[ | [ |
<| [m
o| |
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= [Accessories|
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This section describes the options contained in each AT&TCall menu.

File

The File menu contains the following options:

u
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= |Print Setup..)
= |Print Cards...|
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a [Print List...
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m
X
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New

Creates a new, empty AT&TCall file. When selected, this option presents a
default screen with no entries. The window title displays "AT&TCall-
(UNTITLED.DEX)."

Open...

Enables you to open an existing AT&TCall file. When selected, this option lists
the existing AT&TCall files. You may scroll through the list and select a specific
file.

Save

Saves the changes made to the AT&TCall file on which you are working.

Save As...
Prompts you to name the file on which you are working. The default extension
for every AT&TCall filename is ".dex."

Import...
Enables you to import files that are in the comma separated values format
(.csv).

Export
Enables you to export the current card or all cards in an AT&TCall file to a file

that is in the comma separated values format (.csv).

Print Setup...

Displays the Windows printer setup window, allowing you to modify the printer
settings (for example, paper size and print orientation).
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Print Cards...

Enables you to print either all cards in an AT&TCall file or the card displayed

currently. When printing the card(s), you may specify whether you want the
notes associated with the card(s) printed also.

Print List...

Enables you to print specific label fields for each card in an entire AT&TCall
file. You may select a maximum of six labels.

Exit
Exits the AT&TCall application.

Edit

The Edit menu contains the following options:
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o

|
T
Q
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= [Insert Timestamp)|

= [Clear Notes|
= [Edit Card

I

[
Z

ew Card

=]

elete Card|

ind...

|
II

ind Nex
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You can use the Undo, Cut, Copy, and Paste options when you are performing
one of the following tasks:

= editing an existing card
= adding a new card

= working in the Notes field of a card

Undo

"Undoes" the last editing action you performed in a field. For example, if you
change the information in a field and then select "Undo," the field displays its
previous information (that is, the information that was changed).

Cut
Deletes information selected from a field and places it in the Windows
Clipboard while you are editing a card.

Copy
Copies information selected from a field and places it in the Windows
Clipboard while you are editing a card.

Paste

Pastes information from the Windows Clipboard into the current field while you
are editing a card.

Insert Timestamp

Places the day, date, and time in the Notes field for the card displayed. This
information appears in front of the cursor and can be placed anywhere in the
Notes field.
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Clear Notes

Erases the contents of the Notes field for the card displayed.

Edit Card

Enables you to edit the card displayed on the screen.
New Card

Enables you to add a new card to the AT&TCall file.
Delete Card

Enables you to delete the card displayed on the screen.

Find...

Enables you to search for specific characters in each specified field or all fields
on each card in the AT&TCall file.

Find Next

Enables you to find the next card that matches the criteria you specified for the
Find option.
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View

The View menu contains the following options:
= Hide Card
= Show Card
= [Hide Notes|

= [Show Notes|
s |Quick Shift
.
.

= [Next Letter|

= [Prev Letter|

] ort...

Hide Card

Displays only the Quick Dials, the Hang Up button, the Dialpad button, the
Timer button, and the Quick Shift button (if the 25/50 Quick Dial Button option

is selected).

Show Card
Displays the entire card along with Quick Dials.
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Hide Notes

Closes the Notes field associated with the selected card.

Show Notes
Displays the Notes field associated with the selected card.
Quick Shift
Enables you to toggle between the first and second set of Quick Dials.
Next Card
Displays the next card in the AT&TCall file (as sorted).
Prev Card
Displays the previous card in the AT&TCall file (as sorted).

Next Letter

Enables you to "jump"” to the next letter that contains a card in the AT&TCall
file.

Prev Letter

Enables you to "jump" to the previous letter that contains a card in the
AT&TCall file.

Sort...

Enables you to specify the primary and secondary labels by which the cards in
your AT&TCall file are sorted.
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Setup
The Setup menu contains the following options:
= Edit Labels...
= Dial Options...

Quick Dial Labels...
[10/20 Quick Dial Buttons|

[25/50 Quick Dial Buttons|

|Always on Top|

Edit Labels...

Enables you to modify any of the labels in the card template for your AT&TCall
file. When selected, this option displays a sample card with the current labels.

You may modify any of these labels.

Dial Options...

Enables you to enter a prefix and/or suffix that you want dialed with every
number. For example, if your telephone system requires that first you dial a "9"
before making an outside call, you can specify "9" in the "Dial Option..." prefix.
By specifying your prefix, you do not need to include a "9" in front of every

phone number on every card.

Quick Dial Labels...

Enables you to display the label button information for the Quick Dials as left-
justified or centered.
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10/20 Quick Dial Buttons

Provides 20 Quick Dials for you to program and use. AT&TCall only displays
10 Quick Dials at a time. To access the second set of 10 Quick Dials, select

the Quick Shift option from the View menu.

25/50 Quick Dial Buttons

Provides 50 Quick Dials for you to program and use. When you select this
option, AT&TCall only displays 25 Quick Dials at a time. To access the second
set of 25 Quick Dials, either select the Quick Shift button in the lower-right
corner of the AT&TCall window or select the Quick Shift option from the View

menu.

Always on Top

Keeps the AT&TCall window on top of all other open windows, including the
active window. This prevents the AT&TCall window from being obscured by

other windows.

Accessories

The Accessories menu contains the following options:

= Call Log
.
.

Call Log
Enables you to access the Call Log, which contains information on all of the

calls you made from an AT&TCall file.
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Dialpad

Enables you to access the Dialpad window. Using the Dialpad window, you
can place calls from the AT&TCall file.

Timer

Displays the Timer window, which contains a timer that immediately starts
running.

Help

The Help menu contains the following options:
= Contents

= Search for Help on...

= |[How to Use Help|
= |About AT&TCall...|

Contents

Displays the topics in on-line Help.

Search for Help on...

Opens the Search dialog box for on-line Help. You can look up Help
information by entering keywords in the dialog box.
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How to Use Help

Describes how to use on-line Help.

About AT& TCall...

Displays the AT&TCall version number, the number of cards in the current card
bank, the Microsoft Windows version number, the mode in which Windows is
operating, the amount of free memory (KB) available on your system, and the
size of the largest contiguous block of memory (KB) available.
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Overview

This chapter provides the following information:

= [a description of Log Viewer|

= [helpful hints when using Log Viewer]

= [the procedures for running Log Viewer|

= fthe tasks you will perform regularly while using Log Viewer|

= [a description of all the Log Viewer menu options|
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What IsLog Viewer?

Log Viewer is an application that enables you to view entries that are stored in
the PassageWay call log. The call log stores a record entry of the following

calls:
= Every call you make from the Dial buttons of a card or Quick Dials in an

AT&TCall file. The call log does not store entries of calls you make from
your telephone directly or from the Dialpad window in AT&TCall.

= All incoming calls or only the incoming calls you answered (depending

on how you set the Call Logging option in the Options dialog box in
AT&TBuzz). The call log only stores entries of calls that arrive while

AT&TBuzz is running.

Figure 5-1|shows the Log Viewer window.
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......

: PassageWay Leg Viewer
Eile Edit Yiew Setup Help

Sorted By:[Datc & Time iNmst First

| View: |All Calls |Unfittered
| | Text Label Number Type Date & Time
[Irejos,Fernando 9.555-7324 0__12/16/93 83:45pi¢
ayerl ,Jeanne 34384 0 12/16/93 63:52p
ayerl,Jeanne 34384 I 12/16/93 83:22p
6sco's, 9,555-RIBS 0 12/15/93 B4:k3p
34383 I 12/15/93 84:32p
34362 U 12/15/93 84:32p
Keit 34381 8 12/15/93 o4:3%p
36481 I 12/15/93 84:25p
34830 I 12/715/93 Bi:24p)
1dil,Rich 344082 0 12/15/93 B4:22p
i Jelliff,Clen 9,555-3388 0 12/15/93 84:21p
Ricker ,Lisa 75248 0 12/15/93 84:01p
emp ,Dave 34438 I 12/11/93
I 12/82/93

Figure 5-1. Log Viewer Window
The call log can store a maximum of 8,000 entries. When this maximum is
reached, the oldest call entry (that is, entry 1) is overwritten by the newest

entry (that is, entry 8001). Each call log entry consists of the following
components:

= the primary and secondary labels of the card associated with the call.
(For incoming calls, you only get this information if AT&TBuzz is running
in Match to AT&TCall File mode, and a match exists between the
caller ID and an AT&TCall file card.)

= the telephone number associated with the call (that is, the dialed
number for outgoing calls and the caller ID, if available, for incoming

calls).
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If there was no caller ID for an incoming call, one of the following
messages may be displayed:

— "Not Available," which indicates that there was no caller ID
associated with the call.

— "Not Inspected,” which indicates that the call was never inspected
for caller ID.

Refer to ['Using Caller ID Information"|in Chapter 3 for more information
about caller ID messages.

the type of call ("O" for outgoing calls, "I" for incoming calls that were
answered, and "U" for incoming calls that were not answered at this
extension)

the date and time the call started (that is, when the outgoing call was
dialed or the incoming call started ringing)

Log Viewer enables you to perform the following tasks with the entries in the
call log:

view selected entries
sort selected entries
delete entries

move entries from the log to a permanent archive file

print entries
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Helpful Hints

When using Log Viewer, keep in mind the following information:

When the Log Viewer window is open, select the Refresh option from
the View menu to make sure you are viewing all of the entries you have
specified. If you make or receive a call while the Log Viewer window is
open, that entry will not be displayed in the Log Viewer. The Refresh
option insures that all relevant entries are displayed.

The call log stores a maximum of 8,000 calls. Entry 8001 overwrites the
oldest entry in the call log.

By default, the system automatically adds deleted entries to the call log
archive file. The call log archive is an ASCII file in which each field of
data is separated by a tab. The archive file is called PWLOG.ARC and
is located in your Windows directory. This file can be viewed, edited, or
modified by any program that can access ASCII files. If you do not wish
to keep your call log entries permanently, turn off the "Add auto. deleted
entries to archive file" option from the Preferences option in the Setup
menu.

Running Log Viewer

To run Log Viewer, you must access Windows and open the program group
that contains the AT&T PassageWay applications. You can run Log Viewer by
itself, or access it from within the AT&TCall or AT&TBuzz applications. To run
Log Viewer by itself, double-click on the Log Viewer icon. The Log Viewer
window appears. Refer to the following section|describing the tasks that you
will perform regularly while using Log Viewer.
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Tasks

This section describes the tasks that you will use with Log Viewer.

Deleting Entries from the Call L og

To delete entries from the call log:

1. Select the entries that you want to delete from the Log Viewer window.
If you want to select all of the entries in Log Viewer, select Sel ect

Al | from the Edit menu.

The entries that you selected are highlighted.

2. Perform one the following steps:

— If you want to add these entries to the call log archive file, select
Move to Archive from the Edit menu.

The PassageWay Log Viewer dialog box appears, displaying the
number of entries that will be deleted from the call log.

PassageWay Log Viewer

24 entries will be deleted from the log.

These entries will be added to the archive file.

OK Cancel

Figure 5-2. Sample PassageWay Log Viewer Dialog Box
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Select the OK button.

The entries are deleted from the log and added to the archive
file.

— If you do not want to add these entries to the call log archive file,
select Del et e from the Edit menu.

The PassageWay Log Viewer dialog box appears, displaying the
number of entries that will be deleted from the call log.

PassageWay Log Viewer

5 entries will be deleted from the log.

These entries will NOT be added to the archive

file.

Figure 5-3. Sample PassageWay Log Viewer Dialog Box
Select the OK button.

The entries are deleted from the log.
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Printing Log Entries

Log Viewer enables you to print the entries that are displayed in its window.

To print log entries:

1. Using the Filter/Sort Options option from the View menu, view the calls
that you want to print

The specified calls are displayed in the Log Viewer window.

2. SelectPrint View from the File menu.

The entries displayed in the Log Viewer window are printed.

Setting the L og Viewer Preferences

You can set Log Viewer to perform the following procedures automatically:
= delete entries after a specified number of days

= add automatically deleted entries to the call log archive file

[] NOTE:

By default, the call log archive keeps a copy of all entries that are
deleted automatically by the program (for example, exceeding the
maximum number of entries or deleting entries after a certain

number of days). These entries will not be added to the call log if
the "Add auto. deleted entries to archive file" option is turned off.

= display a warning when a specified percentage of the call log is filled
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To set the preferences:

1. Select Preferences... from the Setup menu.

The Preferences dialog box appears.

Preferences

Il Automaticaily deiete entries more than |50 | days oid

X Add auto. deleted entries to archive file

X Display waming when log is |90 | X full

0K Cancel

Figure 5-4 Preferences Dialog Box
2. Select the preferences you want.
3. Select the OK button.



Using Log Viewer

Sorting Call Log Entries

Log Viewer enables you to specify the criteria for sorting call log entries and
the order in which these sorted entries are displayed. You can sort the
displayed entries according to the following criteria:

= text label
= telephone number
= date and time the telephone number was dialed

Sorted entries can be displayed in the order of oldest first or newest first.

To sort entries in Log Viewer:

1. SelectFilter/Sort Options... fromthe View menu.

The Filter/Sort Options dialog box appears.
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Stast fansddiyel: End fnsnsddsvel
o U 1. 1.rm M.
L Date | K I L0 I R N 4 B 4
[ pident O Newsszd

@ AllCalls O Outgoing O All Incoming
I Q incoming - Unanswered O Incoming - Answesed

l'_f:d Types

[~ Sort Opbions

~Sort By
O Text Label
O Number

C Account

@ Date & Time

- Order
@ Oldest Fast

O Newest First

Figure 5-5. Filter/Sort Options Dialog Box

[] NOTE:

| — | |

The Account option is unavailable for this system.

Select the option button of the Sort By option you want.

Select the option button of the Order option you want.

Select the OK button.

Log Viewer displays the call log entries in the order in which you

requested. The top of the window displays the current sorting options.
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Specifying the Calls to be Displayed

Log Viewer enables you to specify which call log entries you want displayed in
the Log Viewer window. You can specify entries according to the following
criteria:

= text label
= telephone number
= date
= call type
To specify the calls to be displayed:

1. SelectFilter/Sort Options... from the View menu.

The Filter/Sort Options dialog box appears.
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-~ Filter/Sort Options
| Fites Options oK |
Erser chataecters to mateh:
[J Tex Label [ ] Cance!
I Enter digitz to match: Help I
I J Number [ 1 - Sort Opbions |
Entes dinits to match: ~Sort By
DCTCORG N i i
I O Numbes l
Stast fmmsddinel: End fmeSddspvt O t
Dose [/ J 1 [dA1 ] Aecount.
— — @ Date & Time
| O oidest O Heweat |
Call Types " Order
@ AllCalis O Outgoing O All incoming @ Oidest First
I I QO Incoming - Unanswesed O Incoming - Answered O Newest Fust I

Figure 5-6. Filter/Sort Options Dialog Box

[] NoOTE:
The Account option is unavailable for this system.

2.  Select the filtering options you want
3.  Select the OK button.

Log Viewer displays the calls that you specified. The top of the window
displays the viewing selection.

5-13



Using Log Viewer

Log Viewer Menu Bar Options

Log Viewer provides the following options in the menu bar:

s File

[ |
o] [<] [
C o |=
c —~
@)

u
T
@
@)

This section describes the options contained in each Log Viewer menu.
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File

The File menu contains the following options:
= Print View
= Print Setup...
s EXxit

Print View

Prints the entries that meet the criteria you specified.

Print Setup...

Displays the Windows printer setup window, allowing you to modify the printer
settings (for example, paper size and orientation).

Exit

Exits the Log Viewer application.
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Edit

The Edit menu contains the following options:
= Copy
= Delete
= Move to Archive

s Select All

Copy

Copies the currently selected information from the Log Viewer window and
places it in the Windows Clipboard.

Delete

Deletes the currently selected information from the Log Viewer window. Once
deleted, this information is no longer present in the call log.

Move to Archive

Deletes the currently selected information from the Log Viewer window and
adds it to the call log archive file.

Select All

Selects all of the entries currently displayed in the Log Viewer window.
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View

The View menu contains the following options:
» Filter/Sort Options...
= Refresh
= Hide Account Field

Filter/Sort Options...

Enables you to specify which calls you want displayed in Log Viewer (that is,
filter), and the order in which you want the calls displayed (that is, sort).

Refresh

Updates the information displayed in Log Viewer.

Hide Account Field

Enables you to either show or hide the account codes associated with the calls
displayed in Log Viewer. A check next to this option indicates that the account
codes will not be displayed for each call. Since AT&TCall does not support the
Account Code feature, you should hide the account codes.
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Setup

The Setup menu contains the Preferences option.

Preferences...
Enables you set Log Viewer to perform the following procedures automatically:
» delete entries after a specified number of days
» add automatically deleted entries to an archive file

» display a warning when a specified percentage of the call log is filled

Help

The Help menu contains the following options:
= Contents

= Search for Help on...

» [How to Use Help

= |/About PassageWay Log Viewer...

Contents

Enables you to access the on-line help for Log Viewer.

Search for Help on..

Enables you to access help information on a certain topic.
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How to Use Help

Describes how to use the on-line help for Log Viewer.

About PassageWay Log Viewer

Displays the Log Viewer version number, the number of entries currently in the
view (that is, the number of entries that meet the criteria you specified), the
capacity of the call log, and the number of entries in the call log.
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Using AT& TConnect

Overview

This chapter provides the following information:

= |a description of AT&TConnect|

= |how to access AT&TConnect]

= [tasks you may have to perform with AT&TConnect]

= |a description of all the AT&TConnect menu options|
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What Is AT& TConnect?

AT&TConnect is the manager for all the PassageWay applications. Even when
a user is not using a PassageWay application, but is using the adapter in
Autodial mode (or "Hayes" mode), the AT&TConnect software ensures correct

operation of the serial port.

Every time you invoke Windows, AT&TConnect is automatically loaded (unless
you removed the AT&TConnect icon from your StartUp group), and its icon
appears at the bottom of your screen. If you did not specify a valid COM port
when you installed the PassageWay software, the system will prompt you for a
COM port when you invoke AT&TConnect. After you specify the COM port,
AT&TConnect retains this information and does not prompt you for it again.

Once AT&TConnect has a valid COM port, the software attempts to
communicate with the adapter. If AT&TConnect is unable to communicate with

the adapter, the system displays a troubleshooting window. When
AT&TConnect successfully communicates with the adapter, the AT&TConnect

icon appears at the bottom of your screen.

Running AT& TConnect

If AT&TConnect is in your StartUp group, the AT&TConnect icon is displayed
automatically at the bottom of your screen when you access Windows. To run
AT&TConnect manually, you must first access Windows and open the program
group that contains the PassageWay applications. To access AT&TConnect,
double-click on the AT&TConnect icon at the bottom of your screen. The
AT&TConnect window appears.
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AT&TConnect

Figure 6-1. AT&TConnect Window
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Tasks

This section provides tasks that you may have to perform while using the
PassageWay applications.

Accessing the Events L og

If you are having problems with PassageWay and receive support from AT&T,
you may be asked to access the Events Log. The Events Log records certain
events for information purposes only and is used for diagnosing a problem.

To access the Events Log:
1. SelectEvents Log... from the Setup menu.

The Events Log dialog box appears.
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. smOiiids mOoUe CINREa

Sat Nov 06 16:52-48 1993 0021:21:54 INF: Normal Mode Exited
Sat Nov 06 16:53:00 1993 0021:22-06 INF: Normal Mode Entered
Sat Nov 06 16:55:23 1992 0021:24:29 INF: Normal Mode Exited
Sat Nov 06 16:56:15 1993 0021:25:21 INF: Normal Mode Entered
Sat Nov 06 16:58:00 1993 0021:27:06 INF: Normal Mode Exited
Sat Nov 06 16:58:15 1993 0021:27:21 INF: Session Termmnated
Sat Nov 06 17:02-50 1993 0000:02:38 INF: Session Started

Sat Nov 0B 17:03:13 1333 0000:00:23 iNF: Config Mode Entered
Sat Nov 06 17:09:38 1933 D000:06:48 INF: Config Mode Exted
Sat Nov 06 17-09:51 1933  0000:07:01 INF: Normal Mode Entered
Sat Nov 08 17:10:41 1853 OO000:07:51 iNF: Normai Mode Ezxited
SatNov 06 17:11:15 1933 0000:08:25 INF: Session Termmnated
Sat Nov 08 17:17:02 1993 0000:03:28 INF: Session Stasted

Sat Nov 06 17:17:18 1983 $000:00:16 iNF: Config Mode Entered
Sat Nov 06 17:19:25 1993 0000:02:23 INF: Config Mode Eated
Sat Nov 06 17:19:38 1933 0000:02-36 INF: Normal Mode Enteted
Cap Mo NC 17-97-24 1QQ2 nnnn-1n:-.n IME. Macwmal bl nda Cultad

SUL TVUY UU ST .6 T JdJd

Sat Nov 06 17: 33‘55 1933

: Nosmal Mode Entered
. Normal Mode Exited

Figure 6-2. Events Log Dialog Box

2.

When finished, select the OK button.

6-5



Using AT&TConnect

Changing the COM Port

6-6

If for some reason you connect the PassageWay adapter to a different COM
port, perform the following steps:

[] NOTE:
You cannot select a new COM port for the PassageWay adapter
while PassageWay applications other than AT&TConnect are
running.

1. Select COM Port... from the Setup menu.
The COM Port Dialog Box appears.

#h COM Port

Select the Communication port for
your Passageway adapter:

@ coM1

O comN2
O a2
O coM4

Figure 6-3. Sample COM Port
Dialog Box

2.  Select the option button of the COM port to which you connected the
PassageWay adapter, and then select the OK button.
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Changing Your Telephone Configuration

If the configuration of your telephone changes, you must provide the updated
information to AT&TConnect. You should perform this procedure if any of the

following events occurs:

You receive a new telephone.

The Inspect or Normal display feature buttons are added, deleted, or
moved.

The number of call appearances on your telephone changes.

The Expansion Adjuncts or External Voice Adjuncts for your telephone
change.

[1 NOTE:
You cannot change the telephone configuration information while

PassageWay applications other than AT&TConnect are running.

To update the telephone configuration:

1.

Select Configure System .. from the Setup menu.

The AT&TConnect Setup - Telephone dialog box appears. The
information displayed in the AT&TConnect Setup - Telephone dialog box
depends on the type of telephone you have. AT&TConnect determines
the type of telephone and then prompts you to specify one or more of
the following options for your telephone:

= telephone model

» the type(s) of expansion adjunct(s) (if any) connected to your
telephone

= the type(s) of external voice adjunct(s) (if any) connected to your
telephone
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Figure 6-4 shows the AT&TConnect Setup - Telephone dialog box for a
7405 telephone, and shows this dialog box for a 7444
telephone.

Use the controls below to select the options which
pertain to your 7405 telephone.

If any of these options are set incorrectly,
PassageWay will not work properly. If you
are unsure about any option, press the Help
button for more information.

~ Expansion Adjuncts

[] Function Key Module
[] Display Module

[J calt Covesage Module

~ External Yoice Adjuncts — |

[] speakerphone

Ml aso i s Ao a__
L] HEauset AGapier

Figure 6-4. AT&TConnect Setup - Telephone Dialog
Box for a 7405 Telephone
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='==' AT&TConnect Setup — Telephone

Use the controls below to select the options which
pertain to your 7444 telephone.

If any of these options are set incorrectly,

PassageWay will not work properly. If you

are unsure about any option, press the Help
button for more information.

External Voice Aduncts Continue J

[ Speakerphone Cancel Setup
[ Headset Adapter

Help

Figure 6-5. AT&TConnect Setup - Telephone Dialog
Box for a 7444 Telephone

The dialog box in contains the Advanced button, while the
dialog box in Figure 6-5 does not. The Advanced button appears in
because the telephone used in this example (a 7405
telephone) does not have a built-in display. Since the telephone used in
Figure 6-5 has a built-in display, the Advance button is not provided.

The Advanced button is provided for telephones that do not have
displays and gives you the ability to use display features such as
caller ID. By selecting the Advanced button, you can specify that your
extension has display capabilities even though you do not have a
display telephone. However, in order for your extension to have these
display capabilities, your System Manager must administer your
extension for display capabilities.
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6-10

2.

[] NOTE:
If you use the Advanced button to specify that your non-display
telephone has display capabilities, PassageWay Solution
considers your telephone to be a display telephone.

From the AT&TConnect Setup - Telephone dialog box, select the
appropriate option(s) for your telephone. For more information regarding
the specific options for your telephone, select the Help button.

When you are finished, select the Continue button.

The AT&TConnect Setup - Lines dialog box appears. This dialog box
presents a representation of the buttons on your telephone.
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\ AT&TConnect Setup — MNES

The diagram below represents your telephone.

Indicate the location of each call appearance on your

telephone by pressing the corresponding buttons on the
diagram until each affected button displays the word "LINE"

as its caption.

You may remove the "LINE" caption from a button by simply
pressing it again.

When you are finished making changes, press the Continue
button.

]

__ ]
@ ﬂi'mn\tsx " ]
Broe o | || |

aRE p—
aan | | ——

Figure 6-6. AT&TConnect Setup - Lines Dialog Box for
a 7405 Telephone with no Display

4. Select the location of each call appearance on your telephone.

The word "LINE" appears on each button you select. If you are not sure

where your call appearance buttons are located, lift your handset and
then press each button. If you hear dial tone and both the red and
green LEDs turn on when you press a button, that button is a call

appearance.
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[] NOTE:

As part of the setup procedure, AT&TConnect will "press"” the
buttons that you specify as call appearances in step 4. If you

specify a button that is programmed as a feature, AT&TConnect
may activate or de-activate the feature when it presses the
button. Be careful to select call appearances only.

5. When you are finished, select the Continue button.

The AT&TConnect Setup - Line Confirmation dialog box appears.

AT&TConnect will now confirm the locations
of your lines.

To begin, please take your telephone
off-hook, then press the Start button.

If you use your telephone or receive an

Incoming call during this procedure, the
procedure will be cancelled automatically.

Stast |

Cancel J

Figure 6-7. AT&TConnect Setup - Line Confirmation
Dialog Box
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6. Lift the handset of your telephone, and then select the Start button.

AT&TConnect verifies that the buttons you selected are call
appearances, and then displays a message box. This message box
states the results of the test Figure 6-8 shows the message box after a
successful test, while Figure 6-9 shows the message box after an
unsuccessfull test.

o Your lines have been successfully confirmed.

You may hang up your phone now.

oK

Figure 6-8. AT&TConnect Setup Message Box for a
Successful Test

AT&TConnect Setup

AT&TConnect has encountered a button position marked as a
line which does not correspond to a call appearance.

Please verify your selections on the "AT&TConnect Setup -
Lines" window, then press Continue to start the confirmation
procedure again.

Also, please check your telephone for any features which may
have been inadvertently activated or deactivated.

Figure 6-9. AT&TConnect Setup Message Box for
an Unsuccessful Test
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If the test is successful, hang up your handset, and proceed to step 7.
If the test is unsuccessful, hang up your handset, select the OK button,

and repeat steps 4 to 6. The incorrect button(s) that you marked as call
appearances will display "(No Line)" and will be grayed.

Select the OK button.

The AT&TConnect Setup - Line Labels dialog box appears.

AT&TConnect Setup — Line Labels

PassageWay maintains a text label for each of your

telephone's call appearances. PassageWay applications use
these labels when referring to specific lines.

Your current line labels are shown below. To change a label,
press the corresponding button, then enter a new label.

When you are finished making changes, press the Continue
button.

i

i
il
T

[l
[l

1
|

¥ REE

a
L.

Figure 6-10. AT&TConnect Setup - Line Labels
Dialog Box for a 7405 Telephone with no Display

6-14



Usi ng AT& TConnect

PassageWay applications such as AT&TBuzz use the Line Labels to
identify where calls are appearing on your telephone. You may
customize the labels to something that will be more meaningful to you.
These labels should be unique, and cannot be blank.

[1 NOTE:
These labels are specific to PassageWay applications. Your

DEFINITY system has its own alphabetic labels that it applies to
the call appearance identifiers on the display of your telephone
(for example, a=) .

8.  Perform one of the following steps:

— If you want to customize the Line Labels, perform the following
steps:

a . Select the label that you want to change.

The Edit Line Label dialog box appears.

b. Enter a new label (up to four characters) and select the
OK button.

If you want to customize another label, repeat steps A
and B.

When you are finished, proceed to step 9.

— If you do not want to modify the Line Labels, proceed to step 9.

9. Select the Continue button.
The AT&TConnect Setup - Line Labels dialog box closes.

If your telephone does not have a display, the procedure is completed.

If your telephone has a display, the AT&TConnect Setup - Display
Features dialog box appears.
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c.~.s AT&TConnect Setup — Display Features

If the "Normal" and "Inspect" display features are assigned to buttons on your
telephone, PassageWay can use them to enhance its calling party ID capabilities.

Indicate the location of these feature buttons, if they are present on your
telephone, by pressing the corresponding button(s) on the diagram and selecting
the appropriate feature name from the popup menu.

When you are finished making changes, press the Continue button.

1 ) J&=q

il

d
T
LU

7

-

ullis:

EEE
][ <o :r][EI 7
[l ][]| &}

Figure 6-11. AT&TConnect Setup - Display Features
Dialog Box for a 7405 Telephone with a Display

The Normal and Inspect display feature buttons enhance the caller ID
capabilities of PassageWay Solution.

If your telephone does not have Normal and Inspect display feature

buttons, select the Continue button. The AT&TConnect Setup - Display
Features dialog box closes, and the procedure is completed.
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If the Normal and Inspect display feature buttons have been added to or
moved on your telephone, perform the following steps:

a. Select the location of the Inspect display feature button on your
telephone.

A submenu appears displaying "Clear Button," "Normal" and
"Inspect.”

b. Select | nspect .

"Inspect” appears on the label of the button you selected.

C. Select the location of the Normal display feature button on your
telephone.

A submenu appears displaying "Clear Button," "Normal," and
"Inspect.”

d. Select Nor nal .

"Normal" appears on the label of the button you selected.

e. Select the Continue button.

The AT&TConnect Setup - Normal/lnspect dialog box appears.
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AT&TConnect Setup — Normal/lnspect

AT&TConnect will now confirm the
your Normal and Inspect buttons.

locations of

To begin, please hang up if your are currently
off-hook, then press the Start button.

If you use your telephone or receive an

incoming call during this procedure, the
procedure will be cancelled automatically.

[ Concel |

Figure 6-12. AT&TConnect Setup - Normal/lnspect
Dialog Box

Make sure your phone is on hook (that is, hang up your handset)
and select the Start button.

AT&TConnect verifies the locations you specified for the Normal
and Inspect display feature buttons.

If the test is successful, the AT&TConnect Setup - Display
Features dialog box closes, and the procedure is completed.

If the test is unsuccessful, the following message box appears.
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AT&TConnect Setup

AT&TConnect could not confirm the location(s) of your "Normal”
and "Inspect" buttons.

Please verify your selections on the "AT&TConned Setup -
Display Features" window, then press Continue to start the
confirmation procedure again.

Also, please check your telephone for any features which may
have been inadvertently activated or deactivated.

Figure 6-13. AT&TConnect Message Box for an
Unsuccessful Test

Select the OK button and then repeat steps A to F.
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Changing the L abels of the Line Buttons

To change the label of a line button:

[1 NOTE:
You cannot change line button labels while PassageWay
applications other than AT&TConnect are running.

1. Select Configure System.. from the Setup menu.

The AT&TConnect Setup - Telephone dialog box appears.

2. Select the Continue button.

The AT&TConnect Setup - Lines dialog box appears.

3. Select the Continue button.

The AT&TConnect Setup - Line Labels dialog box appears.
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o™ AT&TConnect Setup — Line Labels

PassageWay maintains a text label for each of your
telephone's call appearances. PassageWay applications use
these labels when referring to specific lines.

Your current line labels are shown below. To change a label,
press the corresponding button, then enter a new label.

When you are finished making changes, press the Continue
button.

i
L

i
Hinii

11 [

DR

i

%
]

Figure 6-14. AT&TConnect Setup - Line Labels
Dialog Box for a 7405 Telephone with no Display

4.

Click on the button whose label you want to change.

The Edit Line Label dialog box appears.
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Edit Line Label

Enter a new label: oK

a

i

Cancel

Figure 6-15. Edit Line Label Dialog

Box

6-22

Enter the new label (up to four characters) and select the OK button.

The Edit Line Label dialog box closes, and the new label is displayed.

If you want to change the label for another line button, repeat steps 4
and 5.

When you are finished, select the Continue button.

If your telephone does not have a display, the AT&TConnect Setup -
Line Labels dialog box closes, and the procedure is completed.

If your telephone has a display, the AT&TConnect Setup - Display
Features dialog box appears.

Select the Continue button.
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Testing the PassageWay Adapter

If you are having problems with PassageWay Solution, perform the following
steps:

[] NOTE:

You cannot test the PassageWay adapter while PassageWay
applications other than AT&TConnect are running.

1. Select Test Adapter from the Setup menu.

The AT&TConnect Adapter Test dialog box appears.

= AT&TConnect Adapter Test

AT&TConnect's adapter test can assist you in diagnosing
problems with your PassageWay system.

Would you like to perform the adapter test now?

Yes No

Figure 6-16. AT&TConnect Adapter Test Dialog Box

2. Select the Yes button in the dialog box.

The test starts.
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3. Respond to the AT&TConnect Adapter Test dialog boxes (if any).

When the test is completed, the AT&TConnect Adapter Test message
box appears, displaying the results of the test.

[1 NoTE:
If the PassageWay adapter test fails, note the error number and

refer to

4. Select the OK button.
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AT& TConnect Menu Bar Options

AT&TConnect provides the following options in the menu bar:
s File

s Setup
.

This section describes the options contained in the AT&TConnect menus.

File

The File menu contains the Exit option.

Exit
Exits the AT&TConnect software.

Setup

The Setup menu contains the following options:

= |[COM Port...

= |Configure System...|
= [Test Adapter|

= |Events Log...|
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COM Port...
Enables you to select the COM port for your PassageWay adapter.
Configure System...
Enables you to modify the system configuration information.
Test Adapter
Activates a self-test of the PassageWay adapter.
EventsLog...

Records certain events for information purposes only and is used for
diagnosing a problem.

Help

The Help menu bar option contains the following options:
=  Contents

= |Search for Help on.. |

= |How to use Help|

= |About AT&TConnect...|

Contents

Enables you to access the on-line help for AT&TConnect.
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Search for Help on...

Enables you to access Help information on a certain topic.

How to use Help

Describes how to use the on-line help for AT&TConnect.

About AT& TConnect...

Displays the AT&TConnect version number, the PassageWay API DLL version
number, and the number of PassageWay applications (clients) that are
currently active.
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Using Autodialing Applications
with PassageWay Solution

Overview

This chapter provides information for using other Windows applications with
PassageWay Solution. Most applications that are designed to autodial (using
the Hayes command set) can work with PassageWay Solution.

Using Autodialing Applications

Windows applications such as personal information managers (PIMs),
schedulers, and the Windows Cardfile dial phone numbers via modems using
the Hayes' command set They do not use the modem to transfer data; rather,
they dial the phone number you select and expect you, the user, to pick up the
telephone to complete the call.

PassageWay Solution can decode the Hayes' commands necessary to dial a
telephone number. The application that performs the dialing will think there is
a modem connected to your PC, not PassageWay Solution. There are a few
parameters and guidelines that need to be followed to ensure that
PassageWay Solution will operate with your application.
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Setting Up PassageWay Solution

To use PassageWay Solution with autodialing applications, the AT&TConnect
application must be running while the autodialing application is running.

[]

NOTE:

Other PassageWay applications (such as AT&TCall and
AT&TBuzz) cannot be running while PassageWay Solution is
being used by autodialing applications.

Also, when PassageWay applications are running, you cannot
use autodialing applications.
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Setting Up Your Application

Set the following parameters for your application:

Baud Rate

You can use any standard baud rate.

COM port

Make sure you select the same COM port that is connected to the
PassageWay adapter.

Data bits

The data bits (word length) should be set to 7 or 8.

Tone or Pulse dialing

PassageWay Solution is compatible with either type of dialing.

Prefix/Suffix
Whatever number you select for the application to use for a dialing

prefix and/or suffix will be used by PassageWay Solution.

[1 NoTE:
Stop bits and parity are not important to PassageWay Solution.
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Helpful

Hints

7-4

Keep in mind the following information when using PassageWay Solution with
autodialing applications:

Make sure all phone numbers used are appropriate for your DEFINITY
system.

PassageWay Solution will place phone calls for an autodialing
applications. If you have a speakerphone, your speakerphone
automatically goes off hook, and the call is placed. If you do not have a
speakerphone, you must lift your handset. When the call is completed,
you will have to manually hang up your phone (even if you have a
speakerphone).
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Overview

This chapter provides information that can assist you in solving problems that
you might encounter with PassageWay Solution. This chapter is divided into
the following sections:

= ['Troubleshooting AT&TConnect'|
= ['Troubleshooting AT&TCall"|
= ['Troubleshooting AT&TBuzZ'|

Refer to the appropriate section to find the information required to solve your
particular problem. Also, you may want to refer back to the chapters discussing
the PassageWay applications to resolve problems that might arise due to
confusion about how a particular feature works. Keep in mind that AT&TCall
and AT&TBuzz depend on AT&TConnect in order to communicate with your
telephone. As a result, problems with AT&TCall or AT&TBuzz may actually be
caused by a problem with AT&TConnect.
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Troubleshooting AT& TConnect

8-2

This section presents some common problems that you might encounter while
using AT&TConnect. For each problem, a strategy is presented that you can
follow to isolate and solve your problem.

Problem 1: AT&TConnect will not run. It displays the message
This application requires a serial port and terminates.

This message indicates that AT&TConnect cannot find an available serial port
on your system. This message will most likely appear immediately after you
have completed the installation of the PassageWay software using the setup
program since this is the first time AT&TConnet tries to run.

If you do not have an available serial port (for example, if you have only one
serial port, and this port is being used by your mouse), you will need to add an
additional serial port to your PC in order to use PassageWay Solution. Your
computer vendor can assist you in obtaining the necessary hardware to add

another serial port. See |Appendix B|for more information.

If you are certain that you have an available serial port (other than a port being
used by your mouse), the available port might be disabled, in which case
AT&TConnect will be unable to detect its presence. You can verify the number
of active serial ports in your system using the following procedure:

1. Exit Windows and return to DOS.

The DOS prompt appears.

2. Access the directory in which the PassageWay applications reside.
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3. Type contheck and press [ ENTER ].

The status of each COM port in your PC is displayed. The following is a
sample of what you may see:

COMCheck V1.0 (c)1993 AT&T
Serial port detection program

Por t Det ect ed

cov Yes
cowe Yes
COMB No
cowva No

If this procedure reveals that your PC has no active COM ports or only COM1

Is active (but is used by your mouse under Windows), you will need to either
purchase an additional COM port for your PC or consult your PC’s hardware
documentation to determine how to re-enable a COM port that might be

disabled. (Refer to for information on COM ports.) Re-enabling a
COM port may require changing the placement of a jumper on your computer’'s
system board or running your PC’s setup program.

8-3



Troubleshooting

Problem 2: AT&TConnect displays its Communications Error dialog box
within a few seconds after it is run

This message indicates that AT&TConnect cannot communicate properly with
your PassageWay adapter. This message can appear for one of the following

reasons:

= Your PassageWay adapter is not connected properly to your PC serial
port and/or your telephone.

= Your PassageWay adapter is not receiving power.

= AT&TConnect is administered to use a different serial port than the one
to which the PassageWay adapter is connected.

=  One or more cables and/or adapters are damaged, not properly
attached, or not compatible with PassageWay Solution.
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AT&TConnect - Communications Error

AT&TConnect cannot communicate properly with your
PassageWay adapter.

Please follow the steps below, in order, to resolve the problem:

1.

Verify that the adapter is present and properly connected to your
telephone and PC serial port. If the adapter is not present, you
cannot use PassageWay to control your telephone, and you must
press the Exit button below to exit this application.

. Verify that the LED on the PassageWay adapter is illuminated.

If not, verify that the adapter is properly connected to your
line port and that closet or local auxiliary power is available.

. Verify that the proper communications port number [e.g., COM1,
COM2] is selected; you may review your current settings and
make changes by pressing the Port button below.

. Press the Test button to initiate AT&TConnect's adapter

testing routine. During the test, you may be prompted to
inspect the adapter LED you observed in step 2.

If all tests complete successfully, press the Continue button to

re-establish communications between AT&TConnect and the adapter.

If a test failed, note the error code and consult the user
documentation's ['Troubleshooting"| section for more information.

{ Port.. I Test I l Continue ' Exit

Figure 8-1. AT&TConnect - Communications Error Dialog Box
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You should follow the instructions provided on this dialog box to troubleshoot

the problem. These instructions ask you to verify the following items:
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The PC-side and phone-side cabling associated with your PassageWay
adapter is properly connected.

Insure that the 7-foot phone cord is completely inserted into both the
jack marked "Line" of your telephone and the modular jack marked
"Phone" on the PassageWay adapter. A proper connection is confirmed
by a tactile "click" as the cord is fully inserted.

Insure that the phone cord between the wall jack and the modular jack
marked "Line" on the PassageWay adapter is completely inserted into
both the wall jack and the modular jack marked "Line" on the
PassageWay adapter. A proper connection is confirmed by a tactile
“click" as the cord is fully inserted.

Also insure that any RS-232 cables and adapters that you might be
using to connect the PassageWay adapter to your PC should NOT be
null modem cables (a special type of cable), and the total length of the
combined RS-232 cabling should not exceed about 40 feet (the length
should be as short as is convenient for your setup).

Insure your PassageWay adapter is receiving power (as indicated by the
illumination of the power LED).

If you have verified that the PassageWay adapter is properly connected
to your telephone, yet the power LED next to the modular jack on the
adapter is NOT illuminated, your telephone system wiring may not
support the remote powering of adjuncts. If this is the case, you should
consult your AT&T account representative or authorized dealer to obtain
the proper wall supply to power your PassageWay adapter or to correct
any wiring problems which may be the cause.
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Your COM port administration for AT&TConnect corresponds to the
serial port to which the PassageWay adapter is connected.

Under Windows, AT&TConnect considers any active serial port that is
not being used by a serial mouse to be "available" for use with
PassageWay Solution. Consequently, AT&TConnect will allow you to
select a COM port that could be different from the one to which your
PassageWay adapter is attached. For example, if your PC contains an
internal fax/modem card, that fax/modem will be using one of your PC’s
COM ports, and you could erroneously administer AT&TConnect to use
this same COM port. When selecting a serial port for AT&TConnect to
use, you should be careful that the COM port you select is not already
being used by another device in your PC.

AT&TConnect’s software-based adapter test passes.

To assist you in diagnosing problems, AT&TConnect contains a built-in
adapter test procedure. This test can be run directly from the
Communications Error dialog box by choosing the Test button.

If the test procedure concludes successfully, AT&TConnect is
communicating properly with your PassageWay adapter over the COM
port you selected, and you should select the Connect button on the
Communications Error dialog box to restore normal operation.

If, however, the test fails, an error number will be provided. Use the
following table|to interpret the error numbers and to find suggestions for
how to resolve the particular error you encountered.
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Failure Code Meaning Things to Try

-101 The adapter test Try closing one or
could not be more applications,
completed due to then retry the
insufficient memory. adapter test.

-102, -103 The adapter test Close the
could not be application that is
completed because using the
the currently designated COM
selected COM portis | port, then retry the
in use by another adapter test.
application.

-104 The currently Try connecting your

selected COM port is
incompatible with
PassageWay
Solution.

PassageWay
adapter to a
different COM port
on your PC.
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-111

The PassageWay
adapter is not
receiving power.

If you are using an
auxiliary power

supply, verify that it
is properly installed.

(See for

more information.)

If you are not using
an auxiliary power
supply, you will
need to obtain one
unless your
DEFINITY system is
wired to provide
adjunct power to
your extension (your
System Manager
can provide this
information). Your
AT&T sales
representative can
supply you with the
proper power
supply, if needed.
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-112 The connection Verify that the
between your PC’s connection between
COM port and the 9- | your PC's COM port
pin connector on and the
your PassageWay PassageWay
adapter may be adapter is secure.
faulty.
Verify that the COM
port number you
selected during the
AT&TConnect setup
procedure matches
the number of the
COM port that is
physically connected
to your
PassageWay
adapter.
-121 AT&TConnect is not | Follow the
receiving data over instructions for
the specified COM failure code -112.
port.
-122,-142 Your PassageWay Contact your AT&T
adapter has reported | service
an internal problem representative.
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-123, -131, -141

AT&TConnect is
receiving incorrect

data over the
specified COM port.

Verify that the COM
port number you
selected during the
AT&TConnect setup
procedure matches
the number of the
COM port that is
physically connected
to your
PassageWay
adapter.

This failure usually
indicates that the
specified COM port
Is connected to a
modem or data
module rather than
your PassageWay
adapter.

-143

The PassageWay
adapter is not
properly connected
to your DEFINITY
system. The adapter
may also not be
properly connected
to your telephone.

Verify the
connections
between your
PassageWay
adapter and your
DEFINITY system
and telephone.

-144

The PassageWay
adapter is not

properly connected
to your telephone.

Verify the
connection between

your PassageWay
adapter and your
telephone.
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-2XX An unexpected Try closing all
Windows applications except
communications AT&TConnect and
error has occurred. Program Manager,

and then repeat the
adapter test
procedure.

Problem 3: AT&TConnect will not work on COM3 or COM4

By default, many PCs are not configured to permit the simultaneous use of
three or more COM ports. Specifically, most PCs are configured such that
COM ports are grouped into pairs: COM1 is paired with COM3, and COM2 is
paired with COM4. By default such PCs permit only one COM port from each
pair to be operating at the same time (for example, COM1 with COM2). COM
ports within the same pair will usually conflict with one another and are not
supported (that is, COM1 with COM3, or COM2 with COM4).

If you cannot get AT&TConnect to work properly on COM3, check if another
device is using COM1 at the same time. Similarly, if you cannot get
AT&TConnect to work on COM4, determine if another device is using COM2 at
the same time. If so, you may need to make some changes to your PC
configuration to support using PassageWay Solution on COM3 or COM4. Refer
to for more information. If you need additional assistance in setting

up devices on COM3 or COM4, consult your PC hardware vendor.
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Problem 4. AT&TConnnect occasionally displays its initialization window
while one or more PassageWay applications are running

AT&TConnect displays its initialization window whenever it establishes (or re-
establishes) communication with the PassageWay adapter. Generally, this
window is only displayed once, at the time when a single PassageWay
application is first executed. However, if a communications problem occurs at
any time, AT&TConnect attempts to clear the problem by reinitializing the
adapter, which causes the initialization window to reappear temporarily. If this
occurs while a PassageWay application is performing a task involving the
telephone, the operation in progress will be aborted and must be restarted
manually once the initialization window disappears. If no task involving the
telephone is in progress during this process, the operation of PassageWay
applications is unaffected.

The chance of a communications problem depends on your PC’s configuration.
PassageWay Solution operates at a data rate of 9600 baud, and it relies on
Windows to manage the flow of data through your PC’s serial port. Depending
upon the speed of your PC, the number and type of applications you are
using, and various hardware components in your PC configuration, Windows
will be able to manage serial communications with varying degrees of

effectiveness.

If you encounter frequent communications errors using PassageWay Solution,
your PC’s current hardware configuration may not support reliable high-speed
communications under Windows. includes information about
choosing serial port hardware that can work reliably at high speeds under
Windows.
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Troubleshooting AT& TCall

This section presents some common problems you might encounter using
AT&TCall. For each problem, a strategy is presented that you can follow to
isolate and solve your problem.

Problem 1: AT&TCall does not dial or turn on the speaker

AT&TConnect must be running in order for AT&TCall to dial using your
telephone. Run AT&TConnect, wait for your telephone to be initialized, and try
dialing again.

If AT&TConnect will not run (that is, it displays the message "This application
requires a serial port" and then terminates) or if a communications error occurs
(that is, the Communications Error dialog box appears), refer to
['Troubleshooting AT&TConnect."|

Problem 2: AT&TCall dials the wrong numbers

Check if you have a dialing prefix and/or suffix enabled for all cards in this
bank. To disable an unwanted prefix or suffix, select Di al Opti ons from the
Setup menu and select the checkboxes to disable the prefix or suffix.
Remember that prefixes and suffixes apply to every number on every card in a
given bank, so do not make changes to them unless you wish these changes
to apply to all of the cards in the active bank.
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Problem 3: AT&TCall will not allow you to create a new card or edit an
existing card

Both the New Card and Edit Card buttons are disabled (as are a number of
menu items) whenever you are in the process of creating a new card or editing
an existing one. To restore the capabilities of these buttons, you must
complete the adding/editing operating already in progress and return the
new/edited card to the current card bank.

Note that the New Card and Edit Card windows can be minimized, so it is

possible that you may have minimized one of these windows previously and
have forgotten that you did so. If one of these windows was minimized, its icon

will appear in the icon area near the bottom of your Windows desktop. Simply
doubleclick on the icon to restore it to a window, then complete the add or
edit operation by choosing Add Card or Return Card. The New Card and Edit
Card buttons will then be restored.

The New Card button is also disabled when the card bank contains 2,000
cards. Use the About AT&TCall option in the Help menu to determine how
many cards are in the current card bank.
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Troubleshooting AT& TBuzz

This section describes some common problems you might encounter while
using AT&TBuzz. For each problem, a strategy is presented that you can
follow to isolate and solve your problem.

Problem 1: Your phone rings, but no call records appear in the
AT&TBuzz window

AT&TConnect must be running in order for AT&TBuzz to display records for
incoming calls. Run AT&TConnect.

If AT&TConnect will not run (that is, it displays the message "This application
requires a serial port" and then terminates) or if a communications error occurs
(that is, the Communications Error dialog box appears), refer to
['Troubleshooting AT&TConnect."|

Problem 2: You pick up your handset to answer a call, but you do not
get the call you expected

You probably picked up your handset while the phone was inspecting the call.
To be sure, you should always answer from AT&TBuzz, and then switch to the
handset if desired.

Problem 3: AT&TBuzz automatically drops the active call when a second
call arrives

You probably selected the Auto-Drop First Call option in the Options dialog box
of AT&TBuzz. Verify the Answering Second Call setting in the Options dialog
box of AT&TBuzz.
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Problem 4: AT&TBuzz is running in Match to AT&TCall File mode and
you receive calls from numbers that are in the associated AT&TCall file,
but AT&TBuzz does not find any matches

Your area code is probably incorrect. Verify that your correct area code is
displayed in the Options dialog box.

Problem 5: On inside calls, AT&TBuzz does not display caller ID, even
though the name of the person calling appears on your telephone’s

display

AT&TBuzz looks for the calling party number in the display sent by your
DEFINITY system. If the display does not contain a telephone number,
AT&TBuzz will display the message "Not Available."
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Appendix A: Menu Trees

This appendix contains the menu trees for the PassageWay applications.
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= AT&TBuzz v
Setup Controis Help
Run Mode... Answer Contents
Options... Hang Up Search for Help on...
Initialize Paste Link DDE| | Hold How to Use Help
Reset Default Window Show Card About AT&TBuz...
Aiways on Top New Card
Exit Accessories

Call Log

Timer

Figure A-1. AT&TBuzz Menu Tree
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= AT&TCall v
File Edit View Setup Accessories Help
New Undo Hide Card || Edit Labels... Call Log Contents
Open... Cut Show Card |} Dial Options... Dialpad Search for Help on...
Save Copy Hide Notes || Quick Dial Labels... Timer How to Use Help
SaveAs... Paste Show Notes || 10/20 Quick Dial Buttons About AT&TCall...
Import... Insert Timestampy | Quick Shift || 25/50 Quick Dial Buttons
Export p Clear Notes Next Card || Always on Top

All Cards... Edit Card Prev Card

Current Card... || New Card Next Letter
Print Setup. . Delete Card Prev | gitor
Print Cards... Find... {Sort..
Print List... Find Next
Exit

Figure A-2. AT&TCall Menu Tree
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= PassageWay Log Viewer ViA
[File Edit © View Setup Help
] 1 . P

Print View Copy || Filter/Sort Options..[{Preferences..{{Contents

Print Setup...|| Delete Refresh Search for Help on...
I.xi! | Move to Archive Il Hide Account Field How to Use Help
et

Select All About PassageWay Log Viewer...

Figure A-3. Log Viewer Menu Tree
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= AT&TConnect \ 4
File Setup " Help
Exit lcx‘.‘vii Port.. Contents
Configure System...| |Search for Help on...
est Adapter [How to use Help
Events Log... About AT&TConnect..

Figure A-4. AT&TConnect Menu Tree

A-5



Appendix B: PC Serial Ports

Contents
Overview B-1
Background B-2
Serial Ports Under Windows 3.1 B-6
Workarounds and Solutionsto the
|RQ Conflict Problem B-7
Selecting an Add-In Serial Port Card B-10




Appendix B: PC Serial Ports

Overview

This appendix provides detailed information about PC serial ports, including
background information about what they are and how they work, how Microsoft
Windows 3.1 manages them, how to resolve problems using COM3 or COM4
under Windows, and how to choose serial port hardware that is well-suited to
PassageWay Solution. If you are familiar with serial port terminology (for
example, I/O port addresses, IRQs, etc.), you may wish to skip over the
background section. If not, you should review the lbackground section| before
reading further.

If you are having problems using PassageWay Solution on COM3 or COM4,
you should refer to ['Workarounds and Solutions to the IRQ Conflict Problem’]
for advice on solutions and workarounds. If you intend to purchase an add-on
serial port card for use with PassageWay Solution, you should refer to
I'Selecting an Add-In Serial Port Card"| for information that can assist you in

selecting a card.
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Background

Serial ports (also sometimes referred to as communications ports or COM
ports) are hardware interfaces which permit your PC’s microprocessor to
communicate with peripheral devices using a communications standard called
RS-232 (hence, serial ports are also sometimes referred to as RS-232 ports).
Many common computer accessories make use of serial ports, including serial
mice, modems, serial printers, and the PassageWay adapter.

Under DOS (and Windows, which works cooperatively with DOS), the serial
port interfaces in a PC are uniquely identified by specific device names:

COML1 ("serial communications port 1"), COM2 ("serial communications port
2"), and so on, usually up through COM4. A particular PC might have none of
these devices, some of them, or all of them installed. For example, most PCs
currently on the market arrive from the manufacturer with two serial ports
already installed (COM1 and COM2), often integrated onto the computer’'s
main system board. Installing additional serial ports (for example, COM3 or
COM4) is usually accomplished by purchasing an add-on card and installing it
into a free expansion slot.

For most purposes (for example, configuring software), the generic description
of serial ports provided by their device names is sufficient. For example,
during the PassageWay Solution installation procedure, you are asked to
provide the device name of the serial port to which you have connected the
PassageWay adapter (for example, COM2). Unfortunately, this abstract view
of serial ports is not sufficient for other purposes, notably for troubleshooting
problems: to be able to do this effectively, a basic understanding of serial port
hardware is required. In particular, it's essential to understand the mechanics
by which the computer's microprocessor communicates with serial port
hardware.

The microprocessor/serial port communication consists of two aspects: an 1/0O
port address and an interrupt request signal (IRQ). The I/O port address
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represents a small region of the microprocessor’s input/output memory space
which is used to pass data back and forth to the serial port. This memory
region acts something like a mailbox: outgoing mail (data from the
microprocessor to be transmitted to the peripheral device) is placed in the
mailbox by the owner (the microprocessor) to be picked up by the mail carrier
(the serial port hardware) for subsequent delivery to the destination party (the
peripheral device). In turn, the mail carrier (the serial port hardware) places
incoming mail (data from the peripheral device) into the box to be picked up by
the owner (the microprocessor). This analogy illustrates an additional
important point about I/O port addresses: just as individual mailboxes help the
residents in a neighborhood keep their mail from getting mixed up, each device
using an I/O port address to communicate with the microprocessor should
have a unique address that doesn’t conflict with that of any other device.

The mailbox analogy is also helpful in understanding the IRQ mechanism.
Normally, we place our outgoing mail in our mailbox at any convenient time
before the mail carrier arrives to pick it up. The outgoing mail sits in our
mailbox until the mail carrier arrives, at which time it is picked up and possibly
some incoming mail is placed in the mailbox. Then, some time later, we check
our mailbox and retrieve our new incoming mail. The problem with this
scheme is that it's not very efficient: both the outgoing and incoming mail
spends some time just sitting in the mailbox. A better approach would be if the
mail carrier provided some sort of signal (for example, ringing the doorbell) to
announce his or her arrival, in which case we could hand over the outgoing
mail and pick up the incoming mail immediately. In the PC architecture, IRQs
acts like the doorbell in our analogy: they provide a method by which
hardware devices in the computer can get the microprocessor's attention to
efficiently deal with some process. The serial port hardware makes use of an
IRQ to announce that it's ready to receive more outgoing data and/or that new
data has arrived from the peripheral device which needs to be processed.

Like I/O port addresses, IRQs must generally be unique among the active
hardware devices in a computer system. In the mailbox analogy, the doorbell
Is probably not a good signal since virtually anyone could ring the doorbell for
any number of reasons, not just to indicate the arrival of mail. Similarly, if a
particular IRQ signal is used (PCs generally support 16 unique IRQ signals,
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denoted IRQO, IRQ1, and so on, up through IRQ15), the microprocessor must
take the appropriate action for the device associated with that IRQ. If there is
a mix-up, or if more than one device attempts to use the same IRQ at the
same time, a conflict occurs, and the outcome is often unpredictable and
usually undesirable (for example, the computer may "hang"). Because IRQs
are a limited resource, some newer PCs support IRQ sharing, a hardware
mechanism which permits more than one device to make use of the same
IRQ, but most PCs do not. For example, all PCs which use IBM'’s
MicroChannel Architecture (MCA) support IRQ sharing, as do most PCs which
use the Enhanced Industry Standard Architecture (EISA) design. However,
most PCs in the marketplace — even new models — are based on the
traditional Industry Standard Architecture (ISA) which generally does not
support IRQ sharing.

[] NOTE:
IRQ sharing is a PC feature. If your PC supports IRQ sharing,
you can put two COM ports on one IRQ. You will not encounter
the types of complications that this appendix addresses if your
PC supports IRQ sharing.

The specific 1/0 port address and IRQ that a particular serial port uses is
determined by the hardware configuration of the serial port. Generally, these
parameters cannot be changed for built-in serial ports, but add-on cards
containing serial ports often provide jumpers or switches which can be used to
configure them to use one of several I/0 port addresses and IRQ
combinations. The lists the default I/O port addresses and IRQs
used by the serial ports of IBM PC/AT-compatible computers:
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Serial Port I/O Port Address IRQ
Device Name

CcCoM1 O3F8 4
COM2 02F8 3
COM3 03E8 4
COM4 02E8 3

The values in this table play an important part in understanding the "wrinkles"
associated with serial ports: although there is provision for up to four serial
ports, with four unique 1/0O addresses, there are only two unique IRQs
associated with them (recall that most PCs require the IRQs used by each
active device to be unique to avoid conflicts). To understand why, it's useful
to recall what the PC world was like before the widespread availability of
products like Windows. When the architecture of the current generation of
PCs was first being designed (for the IBM PC/AT), the concept of multitasking
was not nearly as important in the PC marketplace as it is today.
Consequently, since DOS (before Windows) did not permit multiple
applications to run simultaneously (with the notable exception of certain
specialized programs such as mouse drivers), there was little need to provide
a mechanism by which several serial ports could be operated simultaneously.
Consequently, the strategy used was to conserve IRQs by assigning the same
IRQ to more than one COM port (that is, the COM1 and COMS3 ports were
both assigned to IRQ4, and the COM2 and COM4 ports were both assigned to
IRQ3). Then, under the assumption that at most two serial ports would be
active simultaneously (for example, COM1 and COM2, which have unique
IRQs), conflicts would not occur.
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Serial Ports Under Windows 3.1

Unlike the DOS-only world of yesterday, today’s multitasking environments like
Windows permit the microprocessor to communicate with up to four active
serial port devices at the same time (COM1 through COM4). For example,
under Windows, if you are using a serial mouse (on COM1) within a terminal
emulator program which operates a data modem (on COM2), while using a fax
board (on COM3) to transmit or receive a fax "in the background,” you are
using three serial port devices simultaneously. You might even wish to make a
phone call using PassageWay Solution (on COM4) at the same time, bringing
the total up to four simultaneously active serial port devices.

The fact that Windows permits this kind of powerful multitasking does not
guarantee that the underlying PC hardware can support this level of operation,
at least without some customizing at the hardware level. Since some PCs can
support it by default (for example, those which support IRQ sharing), Windows
doesn’t prohibit you from configuring your system and attempting tasks like the
one in the previous paragraph. Unfortunately, most PCs cannot support this
operation by default, and the most likely result of attempting the above
scenario is "hanging"” the PC due to an IRQ conflict. On such systems, using
COM1 along with COM2 is generally fine (recall that these devices have
unique IRQs by default), but the addition of COM3 or COM4 causes the
system to fail.

Fortunately, Windows 3.1 permits complete customization of all parameters
involving serial ports through the Control Panel, including configuring
nonstandard 1/0O port addresses and IRQs (that is, values different from those
in the table — these parameters can be viewed and/or modified by selecting
the desired port in the Control Panel’'s "Ports" icon, selecting the "Settings..."
button, then selecting the "Advanced...” button). This flexibility offers the
opportunity of salvation for owners of PCs which do not support IRQ sharing
who require the use of three or more COM ports simultaneously.

B-6



Appendix B: PC Serial Ports

Workarounds and Solutions to the
IRQ Conflict Problem

It is important to remember that the IRQ conflict is a problem in hardware; it
cannot be resolved in software alone. Consequently, there are only three
alternatives for working around or resolving it:

Workaround 1: Configure your serial devices such that you use only two
at any one time, and those two use serial ports with unique IRQs.

This is the simplest workaround to the IRQ conflict problem, but it does not
solve the underlying conflict. The idea is to assign your peripheral devices to
your available serial ports in such a way as to avoid using any devices
simultaneously which might conflict. For example, if you have a serial mouse
on COM1 (IRQ4), a fax'modem card on COM2 (IRQ3), and your PassageWay
adapter on COM3 (IRQ4), you cannot effectively use PassageWay Solution
since you need to use your mouse under Windows while PassageWay
applications are running.

A better arrangement would be to move PassageWay Solution to COM4
(IRQ3), which could then be safely used with your mouse on COM1 (IRQ4). In
this case, the workaround is to avoid trying to use PassageWay Solution at the
same time you use the fax/modem on COMZ2, since the conflict now would be
over IRQ3 (COM2 and COM4).

Workaround 2: Replace one or more of your serial peripherals with
equivalent devices which do not require a serial port.

The idea with this approach is to eliminate the conflict by reducing the number
of peripherals in your system which require serial ports. For example,
replacing a serial mouse with a bus mouse (that is, a mouse which requires its
own add-in card) would make another serial port available that could then be
used by another device.
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Given the scenario described in item (1) above (that is, a mouse on COM1, a
fax/modern card on COM2, and PassageWay Solution on COM3), you might
buy a bus mouse and configure it to use, say, IRQ2 or IRQ5. This would then
permit you to move PassageWay Solution onto COM1 (IRQ4), where it could
then be used simultaneously with both the mouse and the fax/modem.

Likely candidates for conversion from a serial interface to some other interface
include mice (which can be converted to bus mice) and serial printers (which
can be converted to an additional parallel printer port).

Workaround 3: If your serial port hardware permits you to select IRQs
other than the default ones (IRQ3 and IRQ4), make use of one or more
unused IRQs in your system to assign each COM port a unique IRQ.

This solution is generally not possible for built-in serial ports since these are
usually "hard wired" and cannot be changed. Although most add-in cards
containing serial ports permit you to change the IRQs assigned to them, many
cards do not let you select IRQs other than IRQ3 and IRQ4. For example, an
internal modem card generally has jumpers or switches which permit you to
administer the serial interface on the card to be COM1, COM2, COMS3, or
COM4, but the 1/0O port addresses and IRQs associated with each of these
configurations is usually fixed to the settings in the table.

Fortunately, some serial port add-in cards do permit you to select IRQs other
than 3 or 4 (the additional choices are often IRQ2 and IRQ5). If your serial
port hardware provides this flexibility — and at least one of the IRQ numbers
available as an option is currently unused in your PC setup — you can solve
the IRQ conflict directly.

For example, consider once again the scenario of a COM1 mouse, a COM2
fax/modem card, and a COM3 PassageWay Solution. If the COMS3 serial port
Is located on an add-in card which permits IRQs other than 3 or 4 to be
selected, you could configure the COM3 serial port to use a different
(available) IRQ in your system, say, IRQ5. After making the necessary
changes to the card (for example, adding or removing some jumpers or
adjusting the positions of some switches), the last step would be to configure
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Windows to monitor IRQ5 rather than IRQ4 for the COM3 serial port — this is
accomplished using the Windows Control Panel under the "Ports" option (see
your Windows documentation for details).

If you attempt this solution, you must be certain that you do not choose an IRQ
which is in use by some other device in your system — if so, you will only trade
one type of IRQ conflict for another. You should be aware that many common
add-in cards use IRQs, including network cards and multimedia sound cards,
both of which are commonly used under Windows. Your PC hardware vendor
can assist you in configuring IRQs. You may also need to consult the
documentation for your PC and any add-in cards which are installed to
determine which IRQs, if any, are available on your system.
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Selecting an Add-In Serial Port Card

This section presents advice on how to choose an add-in serial port card for
use with PassageWay Solution. Because PassageWay Solution does not have
any unique requirements with respect to serial ports, this advice applies
generically to selecting a serial port for use with any peripheral.

In general, there are two main things to consider when selecting a serial port
for use with PassageWay Solution:

1.

B-10

Choose a card which offers the flexibility to configure its serial port IRQs
to values other than IRQ3 and IRQ4 (for example, to IRQ2 or IRQ5).

This capability often proves to be very beneficial, especially if you are
purchasing the card to add a COM3 and/or COM4 port to your system.
As described at length in "Workarounds and Solutions to the IRQ
Conflict Problem," for PCs which do not support IRQ sharing (which
includes most PCs, unfortunately), the ability to relocate the IRQ for
COM3 or COM4 away from the defaults (IRQ4 and IRQ3, respectively)
represents the only direct solution to conflicts which may arise when
attempting to use COM1 along with COM3 or COM2 along with COM4
under Windows.

If you know your PC does not support IRQ sharing, or if you are not
sure, it's a good idea to purchase a card with this capability. If you
know your PC supports IRQ sharing, this capability is not as potentially
important.

For best performance with PassageWay solution, choose a card which
has hardware support for high-speed communications.
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PassageWay Solution operates at a relatively high data rate (9600
baud), and it relies on Windows to manage the flow of data through
your PC’s serial port. Depending upon your configuration, Windows
may have problems maintaining high data rates through traditional serial
ports. In these situations, a serial port designed for high-speed
communications can eliminate such problems while providing a reduced
load on the microprocessor (thus increasing the performance of
Windows during data transfers relative to standard serial ports). In most
cases, the price differential for such a card is quite modest and a
worthwhile investment.

Many serial port cards on the market (and most built-in serial ports) use
either the 8250 or 16450 Universal Asynchronous Receiver Transmitter
(UART) as their key component. Although these UARTSs can operate at
high speeds, they do not assist the PC’s microprocessor in dealing with
high-speed data transfer. Under Windows, in particular, data can be
lost at high baud rates using these UARTS. If this data loss occurs,
PassageWay Solution cannot function properly.

Whenever possible, select a serial port card which uses the 16550
UART. This industry standard UART is an improved version of the
16450 with hardware support to help offload the microprocessor during
high-speed data transfers. Windows 3.1 has built-in support for the
16550, so no special software configuration is required to obtain the
benefits of the 16550’s enhanced capabilities. In addition, any high-
speed peripheral can benefit from the 16550 (for example, a 9.6 kbps or
14.4 kbps data and/or fax modem), not only PassageWay Solution.

In general, since there is no way of knowing ahead of time if your
particular PC configuration requires an enhanced serial port for
PassageWay Solution, AT&T strongly recommends that you purchase a
card based on the 16550 UART to insure trouble-free operation with
PassageWay Solution.
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Appendix C: Running AT& TBuzz
In Export via Paste Link DDE Mode

The Microsoft Windows operating system provides the Dynamic Data
Exchange (DDE) method for transferring data between applications. One form
of DDE supports a registered clipboard format called "Link." When associated
with the application’s Copy and Paste Link commands, the Link clipboard
format allows the user to establish DDE conversations between applications by
copying a data item in one application and paste linking it into the other.
AT&TBuzz running in Export via Paste Link DDE mode supports this method
for transferring call origin information to other Windows applications.

AT&TBuzz starts up the paste link operation when the user chooses to run in
Export via Paste Link DDE mode or when the user selects Initialize Paste Link
from the Setup menu in AT&TBuzz. This operation destroys the current
contents of the clipboard. The user must then do a Paste Link from the Edit
menu in the other Windows application. In most cases, the process to create
the link between the two applications will only have to be performed once.

After the link is created, AT&TBuzz will send a string of information to the other
application whenever a new caller ID is received. The string contains four
fields. Each field is enclosed by quotation marks and separated from the other
fields by a comma and a space. The string has the following format:

"<handle>", "<caller id>", "<line label>", "<call origin info>"
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where:
= handle is an integer that refers to the handle of the telephone call.

= caller id is the telephone number of the calling party.

= |ine label is the label of the line that the call came in on.
= call origin info is the complete call origin string. For DEFINITY systems,
the call origin info is identical to the caller id.

A macro should be written in the other application to parse the string when it is
received. It may want to look up the caller id in its data base and display that
record. The macro governs what is done in that other application when new
caller ID information is received.

The other application may also want to send information back to AT&TBuzz to
be displayed in the Call Label field of the call record list box. The application
will have to:

1. Initiate a DDE conversation with AT&TBuzz using the "Call_Label" topic.
2. Use the DDE Poke command to send the strings.
3. Terminate the conversation.

The string must be in the CF_TEXT clipboard format and look like this:
"<handle>", "<string of info.>"

where

= handle is an integer that refers to the handle of the telephone call. This
number was passed to the application with the caller ID and should be
passed back to AT&TBuzz so it knows to which call the string belongs.

= string of info. can be anything the application would like AT&TBuzz to
display (for example, the name of the caller). The string can be up to
122 characters in length. If the string contains any quotation marks, they
should be doubled (for example, "James ""Jimmy™ Smith").

The Readme file has examples of macros in some common applications.
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Appendix D: Installing an
Auxiliary Power Supply

Refer to to install an auxiliary power supply for PassageWay
Solution.
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Wall
Power Supply
D6eAP '
Adapter D8W Cable
/z\ Telephone
|7 Phone
\ /
| / L
D8W Cable Passageway
Line
RS-232
PC

400B Adapter

Figure D-1. Auxiliary Power Supply Configuration
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Glossary

A

activate
To begin or turn on the operation of a feature.

AT& TBuzz
Application that enables you to manage incoming calls (answer, hold, or drop)
and view Caller ID (when available) for each call appearing at your telephone.

AT&TCall
A card file application that enables you to maintain information such as names,
addresses, and telephone numbers.

AT& TConnect
Application that manages AT&TBuzz, AT&TCall, and AT&TSet and ensures
correct operation of the serial port to which your PassageWay adapter is
connected.

B

bank
The collection of cards in an AT&TCall file.
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C

call appearance
A button used exclusively to place or receive calls. It has an assignhed
extension number and is equipped with a red in-use light and a green status
light.

call log
A PassageWay file that stores an entry of every call you make from the Dial

buttons of a card or Quick Dials in an AT&TCall file, and incoming calls you
receive while AT&TBuzz is running.

call log archive file
A file in which you may store call log entries. This is an ASCII file in which
each field of data is separated by a tab.

caller ID
The calling party number for each incoming call appearing at your telephone.

card
A data record in an AT&TCall file. This record contains a maximum of 13 data
fields.

comma separated values format
A data file that contains records consisting of horizontal fields of data. Each
field of data is separated from the next field by a comma (,).

D

dialpad window
A window in AT&TCall that functions like the dialpad on your telephone.
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E

expansion adjuncts
Telephone equipment that adds additional buttons or displays to a telephone.

exter nal voice adjuncts

Telephone equipment that plugs into the Other jack on a telephone. This
includes headset adapters and speakerphones.

F

feature
A special function or service, such as Conference, Hold, Send All Calls, etc.

H

handset

The handheld part of the telephone which you pick up, talk into, and listen
from. Also known as the receiver.
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I nspect Button
A display feature button that shows you call-related information for an incoming
call when you are already active on a call. This button is used to identify and
screen new calls.

L

Log Viewer
An application that enables you to view call entries that are stored in the
PassageWay call log.

N

Normal Button
A display feature button that clears special display modes (such as Inspect).
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O

off hook

When the handset is removed from the cradle (for example, when you lift the
handset to place or answer a call).

on hook

When the handset is left in the cradle (for example, when you use the
speakerphone).

S

Spokesman

A telephone with a built-in speaker that allows the user to place calls while on
hook, to monitor calls on which the user has been put on hold, or to retrieve
messages without lifting the handset. However, the speaker feature is for
listening only. In order to speak to the other party, the user must use the

handset (the speaker must be off).
System Manager

The person responsible for specifying and managing the operation of features

for all the voice and data equipment in your network. The actual title of this
person in your company may be different.
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Quick Reference

AT&TBuUzz

Answering a call

If you do not have a speakerphone:

1. Double-click on the record of the call you
want to answer.

2. Lift the handset of your phone.

If you have a speakerphone, double-click
on the record of the call you want to
answer.

Placing a Call on Hold

1. Select the record of the call you want to
place on hold. The selected record is
highlighted.

2.Select Hol d from the controls menu. The
selected call is placed on hold.

AT&TCall

Making Phone Calls

FROM A CARD...

1. Select the card that contains the phone
number you want to dial. The selected
card appears

2. Click on the Dial button located to the
right of the phone number that you want
to dial.

If you do not have a speakerphone, lift the
handset of your phone. AT&TCall places the
call.

If you have a speakerphone, your speaker-

phone activates, and AT&TCall places the
call.

FROM A QUICK DIAL...

Click on the Dial button of the Quick Dial in
which you are interested.

If you do not have a speakerphone, lift the
handset of your phone. AT&TCall places the
call.

If you have a speakerphone, your speaker-

phone activates, and AT&TCall places the

call.

FROM THE DIALPAD...

1. Select the Dialpad button. The Dialpad
window appears.

2. Click on the Dial button.

If you do not have a speakerphone, lift
the handset of your phone.

If you have a speakerphone, the
speakerphone activates.

3. Using your PC keyboard or clicking on
buttons in the Dialpad window, enter the
phone number.

Creating a New Card

1. Select the New Card button. The New
Card window appears.

2. Enter your information.

3. When you are finished, select the Add
Card button.

Editing an Existing Card

1. select the card you want to edit. The
selected card appears

2. Select the Edit Card button. The Edit Card
window appears containing the current
information for the card.

3. Make your changes to the card.

4. When you are finished, select the Return
Card button.

Entering Notes in a Card

1. Select the card for which you want to
enter notes. The selected card appears.

2. Select the Show Notes button. The Notes
field appears.

3. Enter information in the Notes field or
modify the existing information (if any) in
the field.

4. When you are finished, select the Hide
Notes button.
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Quick Reference

Assigning a Phone Number
to a Quick Dial

1.

5.

Select the card that contains the tele-
phone number that you want to program
to a Quick Dial. The selected card
appears.

Press and hold down [ sHIFT ], and then
click on the Label button of the Quick Dial
that you want to program. The Create
Quick Dial dialog box appears.

Enter the label that you want to appear
on the Label button of the Quick Dial.

Select the option button of the telephone
number that you want this Quick Dial to
dial.

Select the OK button.

Re-Assigning an Existing Quick Dial

1.

Select the card that contains the tele-

phone number that you want to program
to a Quick Dial. The selected card
appears.

- Press and hold down [ sHIFT ], and then

click on the Label button of the Quick Dial
that you want to change. The Change
Quick Dial dialog box appears.

- Select the Create New button. The

Create Quick Dial dialog box appears.

- Enter the label that you want to appear

on the Label button of the Quick Dial.

. Select the option button of the telephone

number that you want this Quick Dial to
dial.

. Select the OK button.

Specifying Calls to be Displayed

1.

SelectFilter/Sort Options... fromthe
View menu. The Filter/Sort Options dialog
box appears.

- Select the filtering options you want.
- Select the OK button.

Deleting Entries from the Call Log

1.

Select the entries that you want to delete
from the Log Viewer window. The entries
that you selected are highlighted.

. Select Move to Archive from the Edit

menu if you want to save these entries to
the Call Log archive file, or select Del et e
from the Edit menu if you want to delete
these entries without adding them to the
Call Log archive file.

On-Line Help

To access on-line help for any of the
PassageWay Solution applications, access
the Help menu or press [ F1].
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